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NOTICE 

 
The purchase of the KCAM© software grants the purchaser the license to use the software, not the ownership of the 
KCAM© software. 
 
This document may not be copied in whole or in part without the expressed written permission of Kern Electronics & 
Lasers, Inc. 
 
Although every effort has been made to assure that the information in this document is accurate and complete, Kern 
Electronics & Lasers, Inc. shall not be liable for any direct, indirect, incidental, or consequential damages resulting from 
any deficiencies in this document. All information in this document is subject to change without notice. 
 
Kern Electronics & Lasers, Inc. makes no warranty as to the usefulness of its products for any particular application. It is 
the Buyer’s responsibility to develop processes within the operating envelope of Kern products.  
 
The user must understand the hazards of motion control systems and lasers before operating the software and hardware. 
Kern Electronics & Lasers, Inc. will not assume responsibility for failure to operate the Kern Laser System automated 
equipment in a safe manner. If you, the customer, have questions about operating a Kern Laser System, please call the 
factory for written assistance. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 
 
Contact Information 
 
 
Kern Laser Systems 
1501 Industrial Drive 
Wadena, MN 56482 U.S.A. 
 
Phone: 218-631-2755 
Fax: 218-631-3476 
Email: info@kernlasers.com 
Website: www.kernlasers.com 
 
Office Hours 
 
Monday – Friday: 8AM – 4:30PM Central Time 
 
Customer Service 
 
Toll Free: 888-660-2755 (US and Canada) 
Phone: 218-631-2755 
Email: help@kernlasers.com 
 
Sales 
 
Toll Free: 888-660-2755 (US and Canada) 
Phone: 218-631-2755 
Email: sales@kernlasers.com 
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A Message from our President 

 
Thank you for choosing a Kern Laser Cutting and Engraving System. All of our systems are 

designed, built, tested, and delivered with quality, productivity and customer satisfaction 

in mind. With proper care and minimal maintenance of your system, you should receive 

years of productivity from your laser system. If you encounter any problems or have any 

questions about your system please call us for assistance. 

 
 
Thank You, 

 
  
 

Derek Kern 
President

 



 

 
Congratulations on the purchase of your KERN LASER SYSTEM! 
 
Everyone at Kern takes great pride in manufacturing a quality laser system and providing the best technical 
support for years after the sale. Feel free to give us a call when in need of assistance with your Kern Laser 
System. 

 
Please take time to review the instructional videos posted on the kernlasers.com website. This will aid in 
connecting all the components of the system and get everything aligned and calibrated before operation can 
begin. All connections are labeled at the factory to help simplify the process. Everyone operating the laser 
system must read and understand the Kern laser manual before using the system. 

 
Installation of a phone next to the laser system is encouraged and will help in expediting troubleshooting and 
answering any technical questions that may arise about our software or operation of the system. 

 
All components need to be inspected during setup and installation of the system to make sure damage did not 
occur in the shipping process. Please call Kern immediately at 218-631-2755 with any questions or concerns. 

 
 
Safety 

 
Please read through these basic safety guidelines before operating the laser system: 
 

• Never leave the laser system unattended while cutting or engraving. 
• Always wear rubber gloves or finger gloves when handling the optic lens. Lenses are made of zinc 

solenoid and can be harmful to your health. 
• Cutting acrylic or thicker material at slow speeds and/or low air pressure may cause fires. 
• The 1” honeycomb grid and 1” ecolite grid must be cleaned on a regular basis and replaced if needed. 

If material residue buildup accumulates in the grid work, materials may catch on fire during the 
cutting and/or engraving process. Clean with detergent and water. 

• Clean and remove any material buildup from the bottom of the table’s vacuum chamber. If the black 
painted surface is worn, remove the grid work and recoat the worn spots inside of the table’s vacuum 
chamber with hi-temp flat black spray paint. Wait for the paint to dry and fumes to subside before 
operating the system. 

• The LaserCELL is a Class I laser system. Never override the machines interlock system to allow 
operation of the equipment with the doors or windows open. 

• Laser cutting and engraving are extremely high temperature burning processes. Many materials may 
emit harmful gasses when cut or engraved with a laser. Refer to the materials MSDS safety sheet to 
verify if the material is safe to laser cut or engrave before proceeding. 

• Use proper ventilation within the room housing the laser system. The exhaust air from the vacuum 
blower may need to be filtered for certain types of materials. 

• At least one person must be assigned as the Laser Safety Officer (LSO).  Their duty is to fully 
understand and train all other personnel on safe operating procedures and aspects of the laser 
system. Call Kern with additional information regarding LSO training. 

• It is imperative to understand the hazards of operating a motion control system equipped with a laser 
without proper training. 

• Do not stare at the laser beam when cutting or engraving. Small amounts of ultra-violet light can be 
emitted from the vaporized material. 

• Operators are not to be under the influence of drugs or alcohol. 
• If safety questions arise, please call Kern at 218-631-2755 for assistance. 
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Guards and Covers 

 
Operators and maintenance personnel are protected from hazards on the machine by close fitting sheet metal 
doors, fixed metal panels and sliding polycarbonate access windows. Fixed sheet metal doors are located at 
each end of the machine and are interlocked. Sliding access windows are located on each side of the machine 
and are interlocked. The interlock circuits are considered a necessary part of this machine and should never be 
compromised to allow for system operation if the front doors, side windows or gantry lid are in the open position. 
The bottom portion of the machine has fixed metal panels which are secured in place with bolts. These panels 
are a necessary component of the machine and should not be removed when there is power to the laser. 
Authorized personnel can remove these panels for maintenance procedures if the main electrical breaker for the 
system is OFF.  Inside the system enclosure is there a hinged lid that runs the full length of the gantry which 
can be lifted to gain access to the optical assembly of the laser and X axis drive system.  
 
Operating Modes 
Kern’s LaserCELL model is normally operated in Automatic mode. In Manual mode it is possible to fire the laser 
source, operate X and Y motion systems and check air pressure. Manual mode can only be used if all safety 
interlocks are in operation. Manual Mode is normally used to test or calibrate the laser system. 
 
Access to Manual mode is password protected 
Manual mode can be password protected so operators cannot enter this mode without password permission. 
 

 
Laser Processed Materials and Applicable Standards 

 
Laser material processing can generate by-products as air contaminants that can be noxious, toxic and even 
fatal. The resulting vapors, fumes, and/or particles should be thoroughly evaluated and the adequacy of your 
provisions for fume extraction, filtering and venting should be carefully considered. 
 
Refer to Section 7.3 of  the ANSI Z136.1-2007 “American National Standard for Safe Use of Lasers”, to the 
exposure criteria in 29 CFR 1910 Subpart Z from the United States Government, and to the Threshold Limit 
Values (TLV’S) published by the American Conference of Governmental Industrial Hygienists (ACGIH). 
 
It may also be necessary to consult with state or local government agencies regarding restrictions on the 
outdoor venting of vapors. 
 
Before cutting or engraving any material, acquire the MSDS Safety Data Sheet for the material to verify the 
product is safe to cut or engrave. Fumes from the cut material may be toxic. 

 
 
CDRH Standards 
 

This laser system complies with the requirements of the current version of the following: 
 
U.S. Department of Health and Human Services, Title 21 Code of Federal Regulations, Subchapter J, Part 
1040.10, Performance Standard for Laser Products. 
 
The above regulation is sometimes referred to as the CDRH regulation, the FDA regulation or 21CFR 1040. 
 
It is recommended to strictly follow the user requirements in the ANSI Z136.1-2007 “American National 
Standard for Safe Use of Lasers”. These standards deal with such subjects as the appointment of a laser 
safety officer, the operation of the system in a limited access area by trained authorized personnel and the 
posting of signs warning of the potential hazard. The ANSI Standard manual is available from the Laser 
Institute of America. Call 1-407-380-1553 or visit www.laserinstitute.org to obtain a copy. 
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Material Capability and Fume Extraction 
 
 This is a list of common materials which can be processed with the laser system. If your material is 
not listed please contact Kern for fume extraction requirements. 
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Mandated Safety Labels 

 
The following labels have been affixed to the laser system and should be plainly visible to the operator. 
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CDRH Procedures for Compliance 
 
 Beam Shutter/Attenuator 
 

Closing the shutter on the back of the gantry will mechanically block the path of the laser beam output and 
electronically disable the laser signal to the KLMC box. The Shutter LED on the KLMC box turns red when the 
shutter is in the closed position. 
 
 
Key Switch 
 
To enable the laser, the key switch on the front of the KLMC box must be cycled from OFF to ON. After a 5 
second delay the Laser Enable LED will turn green signifying the laser is capable of being enabled. The laser 
will not fire with the key switch in the OFF position. 
 

 
Indicator Lights 
 
The KLMC box will power on when the ‘Laser System Start’ button is pressed on the system’s main electrical 
panel. Refer to the KLMC section in this manual for a complete description of each indicator light. 
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Class 1 Interlocked System 
 
The LaserCELL is a Class 1 system with a complete protective housing and interlocked access doors and 
windows. If a door or windows is opened during operation the systems motion will pause and the laser signal 
disabled. 
 

 
ID/Cert. Label 
 
Lists model and serial numbers, manufacture date, electrical ratings and compliance codes. 

 
 
System Requirements 
 

Listed are the requirements for your system to run properly. Failure to adhere to the following requirements will 
void all warranty of the laser tube and system. 
 
 
Computer (Minimum Requirements) 
 
Windows 7 or 10. 
Quad Core, 8MB, 8T, 2.8GHz 
8GB RAM, 256 GB Solid State Hard Drive 
 
NOTE: The computer used must be dedicated to the laser system. While the system is operating, all programs 
not associated with the laser or CAD programs must be shut down. Any additional programs running in the 
background may cause interruption in the data flow to the laser system which may cause errors in the KCAM 
software. All screen savers must be disabled as well. 
 
 
Air Supply (Minimum Requirements) 
 
65 – 90 PSI of clean, dry air (Volume of 3 CFM) 
 
Air must be filtered before it reaches the laser system for both oil and water. 

 
Recommend 5 micron pre-filter and 0.1 micron filter. 

 
Oxygen and nitrogen may be used for metal cutting (regulated for 0-150 PSI output). 
 
Must use separate air lines for compressor air and oxygen/nitrogen to back of laser system. 
 
Power Requirements 

 
Due to electrical panel variations please contact your salesman for the exact electrical requirement of your 
system. 

 
Purge Gas 
 
Laser systems of 250 watts and greater require a 2.8 lpm (5.85 scfh) flow rate of purge gas to the ¼” 
air push connector located at the back of the laser system. 
 
It is the responsibility of the customer to provide nitrogen or compressed air that meets the specifications 
mentioned in the Purge Gas Section of the System Setup Chapter. Failure to comply with these 
specifications will void the warranty and the customer is responsible for all cost of repair or damage to the 
laser. 
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Laser System Environmental Specifications 
 
Ambient Temperature: Temperature controlled to 73.5 degrees Fahrenheit. 
 
Relative Humidity: < 95% non-condensing for laser coolant inlet temperature 
 
Operating Altitude: < 6,600 feet 
 
Chiller Coolant Set point: 69.8 Degrees Fahrenheit – 77 Degrees Fahrenheit 
 

 
Operations in Humid Environments 
 
The cooling fluid of the laser can condense moisture from the air when the temperature of the 
cooling fluid is lower than the dew point of the air. Condensation may form on any component 
surface when the surface temperature is at or below the dew point. The system must not operate 
under these conditions since it will lead to failure of the laser head and will void the warranty of the 
laser. Failure to comply with these specifications will void the warranty and the customer is 
responsible for all costs of repair to the laser. The laser will need to be returned to the manufacture 
for repair. 

 
 

The conditions that lead to a situation where there can be condensation are warm and humid 
weather combined with chiller fluid that is cooler than the surroundings. High risk conditions that 
will lead to condensation are: 
 
• Operating the laser in a room that is not air conditioned in high humidity conditions. 
• Using cooling fluid that is not temperature controlled. 
• Leaving the cooling fluid on when the laser is not operating for extended time periods. 

 
Risk of Condensation: The information required to determine if the cooling fluid temperature will 
lead to condensation is: 
 
• Room Temperature 
• Relative Humidity 
 
Since weather conditions change, these factors need to be periodically checked especially in the 
spring and summer seasons. In environments that are air conditioned, we recommend setting the 
cooling fluid to 73.5 degrees Fahrenheit. 
 
Warranty 
 
In the event that a laser or RF module is determined to have failed due to improper purge gas use 
and/or environmental specifications, the warranty of the unit will be voided by the laser 
manufacturer. It will be the customer’s responsibility to pay for the needed replacement parts and 
to ensure the proper purge system is in place before new parts are installed. 

 
 
Additional Components 

 
Additional components the end user may need to purchase are: distilled water for chilling unit, power cord for 
connection to the electrical panel, air compressor with hose connection, venting hardware for exhaust system, 
additional hose for the blowers and paper for sealing the table top vacuum. 

 
 
 
 

7 



 

 
  

Refer to the Kern website link http://www.kernlasers.com/customer-login/ for system setup videos.  
 
Description 
 

The LaserCELL machine consists of a rectangular frame that is constructed from heavy angle section 
steel. The frame has four uprights on each corner, which act as legs and additional support beams 
along the length of the stand. These support a worktop table that is made of steel plates. The table 
has a flat base and is welded on top of the legs. There are ribs that run the full length of the worktop 
to stiffen the table. These are structural members and are deep enough to create a plenum for the 
extraction of dust or toxic fumes generated during engraving or cutting operations. Aluminium 
ecolite and honeycomb grid layers form the worktop. Flexible ventilation hoses are connected to 
ducts at the rear of the machine which provides fume removal and vacuum hold down for the table 
top. Blowers are provided to create the vacuum and collect dust and toxic fumes. Worktop grids are 
designed to suit the various materials that can be cut or engraved by the laser system. Materials to 
be cut or engraved must be flat to within 1 mm to 2 mm. This flatness will ensure that the material 
will be held under vacuum. Crossbeams run between the legs at a lower level. These are positioned 
above floor level and are covered by flat plates on three sides.  The flat plates receive the control 
system enclosure and a DC power supply and guide a roll track. 
 
A gantry runs above the honeycomb grid and spans the full width of the table. The gantry is able to 
travel the full length of the worktop table. The top gantry has two vertical columns at each end. 
These are connected to a bearing block assembly at each side of the machine. The bearing block is 
specially shaped and each block runs along guide rails that are secured to the underside of the 
worktop table. Each bearing assembly is on  a linear rail which is driven by a servo motor and rack 
and pinion drive. 
 
The front of the gantry carries an optical head that travels the full width of the worktop table. The 
optical head consists of a laser tube containing a lens, a means of injecting an assist gas that is used 
to keep the lens clean and an optical nozzle. The optical head is optically connected to a laser 
source. The optical head is mounted on a linear bearing that runs the full width of the gantry. A 
bearing block is mounted on one side of the carrier. The bearing block is specially shaped and runs in 
a guide on the side of the carrier. The bearing block is bolted to the top gantry frame. A direct drive 
servo motor is mounted on the other side of the carrier bolted to the top gantry frame. A timing belt 
runs around the bearing block pulley and the servo motor pulley and is connected to the optical head 
on each side. This enables the optical head to be traversed in the X-axis. 
 
The optical head moves in a vertical plane and is adjustable in the Z-axis by loosening the nylon lock 
handle on non-metal cutting system. 
 
The optical head on a metal cutting system is guided by linear bearings that are supported by the 
optical head. The optical head is connected to a lead screw and a timing belt connects the lead screw 
to a stepper motor. The stepper motor is mounted on the carrier enabling the optical head to be 
traversed in the Z-axis. The lead screw has a spring loaded ant backlash nut that is mounted on the 
side of the optical head. The lead screw runs in a sealed bearing at the top of the carrier. Two limit 
switches are used to determine when the optical head has been driven to its maximum upper and 
lower limits of travel. 
 
The top of the gantry carries a CO2 laser source. The laser source is excited by a DC RF power 
source. On water cooled models, the RF source must be water cooled. A chiller provides cooling 
water and must be set to operate at a temperature of 20 to 21°C (68 – 70 °F). The LaserCELL 
machine must not be operated in a room at a temperature in excess of 27 °C (80 °F). 
 
The laser is first directed at a mirror that turns the beam through 90°. The beam is then directed at  
a second mirror that turns the beam another 90°.  The beam is then directed to a further mirror that 
turns the beam 90° down towards the table top. These three mirrors can be adjusted to align the 
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beam to the center of the mirrors with the help of alignment disks. On leaving the optical head the 
beam is thereafter directed at the work piece. 
 
The LaserCELL laser system operates from instructions that are loaded onto a computer. Various 
operating menus are accessible through the computer and are presented in different windows. The 
control system manages the position of the laser head, laser intensity, rates of acceleration and 
deceleration, cutting speed and many other fine adjustments. 
 
Cutting or engraving instructions on the computer are converted with the KCAM software into 
information that is recognized by the machine. KCAM software is used to control all movements of 
the machine and the intensity of the laser. 
 
Any safety limitations such as maximum laser intensity, cutting speeds or limits of travel are 
controlled by software and independently backed up by electromechanical control systems or 
firmware to establish Category-3 architecture as detailed in EN13849-1. 
 
The acceptable engraving speed range is from 0.1 inches per second to 150 inches per second for 
non-metallic materials and 0.1 inches per second to 130 inches per second for metals. The 
acceptable cutting speed range is from 0.1 inches per second to 10 inches per second.  In one mode 
of operation the modulation frequency sets the intensity of the laser. This ranges from 50 – 100,000 
Hz. In another mode of operation a pulse rate sets the intensity of the laser. This ranges from 0 to 
600 pulses per inch.  
 
The 100W and larger machines must be configured with metal cutting hardware to successfully cut 
metal. High pressure assist gas must be passed through the optics to initiate a cut and achieve a 
clean edge. The KCAM software and a pressure regulator valve control the use of this assist gas. 
 
The 250 and 400 watt machines have a beam protection system that compensates for reflective 
metals like aluminium. When cutting or engraving non-metallic materials aluminium honeycomb or 
aluminium ecolite grids must be used to receive the work piece. A metal cutting grid must be used 
when cutting or engraving metals. The optical nozzle must also be replaced with a ceramic isolator 
nozzle. The plastic safety shield for the optical nozzle must be removed because the higher 
temperatures involved can create a fire hazard. 
 
Blower pulls through three ports at the back of the system. This blower removes fumes and small 
debris that drops into the table chamber. 

 
 
Intended Purpose 
 

The LaserCELL machine in principle is a high speed machine capable of operating at speeds of up to 
150 inches per second using a laser beam that operates at a consistent power level to provide high 
quality laser cutting or engraving over the entire area of the laser worktop. A gantry, which spans 
the full width of the worktop, carries one optical head. This head can span the width of the table in 
less than one second and accelerate at a rate of 5G. The machine can achieve resolutions from 50 
dpi to 1200 dpi. Normally the machine is offered with resolutions from 300 dpi and 600 dpi. 
 
Cutting and engraving speeds are determined by the laser size, material being processed, and the 
desired edge quality. The machine operates at its highest speed when cutting in straight lines, and 
slows down when cutting patterns as they become more intricate. Typical cutting speeds range from 
150 mm (6 inches) per minute up to 15 m (600 inches) per minute. Cutting speeds and laser power 
are adjusted by selecting line colors that are generated by KCAM software. 
 
The LaserCELL model is designed to cut wood, metal, and plastic. Other materials can be cut, but a 
MSDS sheet must first be reviewed first. As a result of laser cutting and engraving operations, many 
of these materials produce toxic fumes when they are heated therefore blowers are provided to 
remove such material. Material that is collected must be removed by a dust extraction system 
provided by the user. The required extraction rate is 42,475 Liters/minute (1500 cfm). See Material 
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Capability and Fume Extraction page. If there are any doubts, users should perform a hazard and 
risk assessment on given material or contact Kern for advice. 
 
The machine is capable of receiving flat material up to a thickness of 75mm (3 inches). Operating 
instructions identify full details of the dimensions of the materials that can be handled. 
 
This Kern LaserCELL model is designed for use indoors in a normal working environment. The 
intended operating temperature range is 16 - 32 degrees Celsius and a relative humidity range from 
50 - 75%. 
 

 
Lighting 
   

LED lighting is installed inside of the machine to provide sufficient light for operators to view all parts 
inside of the machine. 
 
Internal lighting should achieve a light intensity of 100 to 200 Lux (Lumens/m2). 
 
It is recommended that local ambient lighting should achieve a light intensity of 300 Lux (Lumens/m2) 
around the LaserCELL machine and in the immediate vicinity of those parts of the machine where 
maintenance must be performed. 

 
Uncrating 

 
Carefully inspect the crate before it is unloaded from the delivery truck. Note any damage to the 
crate with the shipping company driver and call Kern immediately.   
 
Open the crate using a drill with a Phillips head bit. First remove the screws from the top of the 
crate, next remove the 2”x4” roof supports, then the ends and sides. Once inside the crate inspect 
the laser system and all boxes inside for any visible damage. All boxes may then be removed from 
the crate. Remove lag screws that hold the system to the pallet. 
 
         

Material Handling, Floor Space and Leveling 
 

The center of gravity is located at the center point of the crate. A forklift with extensions may be 
needed to move the wooden crate the machine is shipped in. The chart below shows the dimensions 
and weight of the laser machine. 

 
  
 
 

 
 
          Footprint Chart (access doors closed, computer arm not considered) 
 

Approximately 4 – 6 feet of clearance around the machine is needed to safely operate and perform 
maintenance on the laser system. The front and back access doors also extend beyond the noted 
footprint when they are in the open position. The computer arm also extends beyond the noted 
footprint and can be positioned to the side or front of the machine. Complete footprint schematics 
are available online and in the Systems Diagrams chapter. 

 
Leveling the table may be necessary using shims or leveling pads underneath the legs. Make certain 
the bottoms of all legs are tight to the floor. Do NOT bolt the stand to the floor as this may twist the 
table. 
 
 
 
 
 

 

Table Size Length Width Height Weight 
 

52” x 50” 
 

82 inches 
2083 mm 

74 inches 
1880 mm 

76 inches 
1930 mm 

3700 lbs 
1679 kg 
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Computer / Monitor / Arm 
 

Remove the keyboard portion of arm from its box and install onto the arm assembly. Remove the 
computer and monitor from their boxes. Place the computer into its sleeve located on the arm. 
Mount the monitor on the arm using the four small bolts provided.  
 
Verify that the computer and monitor are able to be connected to a 230V supply. Power information 
can typically be found on the back of the computer and monitor. Connect the power cables to both 
the computer and monitor. Two 230V cords are provided at the arm to connect the monitor and 
computer.  
 
The mouse and keyboard can connect to the USB ports on the back of the computer tower.  
 
Plug in the monitor cable to the computer tower and also to the back of the monitor. Wires that run 
through the monitor arm can be accessed by removing the screws from the plastic plates on the 
underside of the arm. 

 
 
Mounting Laser on Gantry  
  

Make sure to save all boxes for the laser and its components for future servicing. If the laser is not 
returned in its original box, you will be charged for a new one to ensure proper packaging during 
shipping. All power to the laser system must be disabled/off at this time. 
 

 
 
ULR-30/ULR-50 Universal Lasers 

 
Remove laser from the box. Set the laser on the backside of the gantry on the two metal mounting 
brackets. Snug the laser forward so that the beam output of the laser is pushed up against the black 
metal tube of the shutter block. From underneath the top gantry plate, use a hex wrench to tighten 
the four bolts inside of the mounting brackets to the bottom of the laser plate. Make sure the bolts 
are tight and that the laser has no movement.  

   
Unplug the DC power supply plug from the outlet underneath the laser table. Plug the laser harness 
into the connector on the back of the laser. Tighten the screws on each side of the connector to 
ensure that it will not come loose. 

   
The laser is now installed and is ready for beam alignment. Reconnect the DC power supply plug 
underneath the laser table before powering up the system. 

  
 

    
                 Universal Laser Mount 
  
 

Kern 100/150/200 Lasers 

11 



 
 

Remove the laser from the box. Remove plug from laser output. Attach the output block to laser with 
screws provided. 

 
Remove three screws from laser blocks ensuring the two spherical washers stay flat after removing 
each bolt. Slide laser into place and verify both washers stayed in place at all three bolt locations.  
Tighten the three bolts into laser block to secure the laser in place. Make sure that the laser has no 
movement. 

   
Unplug the DC power supply plug from the outlet underneath the laser table. Connect the Black  
(-) and Red (+) power cables from the power supply to the lasers 44 VOLT GROUND (-) and +44 
VOLTS DC (+) terminal posts on the back of the laser. A wrench for both nut sizes is provided in 
the Kern optics kit.  

   
Plug the laser harness into the connector on the back of the laser.  Tighten the screws on each side 
of the connector to ensure that it will not come loose. 

 
Insert the “Water In” and “Water Out” water lines to the fittings on the back of the laser. The water 
lines circulate cooled water between the laser and chilling unit to prevent overheating.The laser is 
now installed and is ready for beam alignment. Reconnect the DC power supply plug underneath the 
laser table before powering up the system. 

 

   
             Back of Kern Laser                                                                              Kern 100/150/200 Laser Mount 

 
J3 250W / J5 400W Coherent Laser 

 
Open the crate containing the laser and locate the Coherent Unpacking Guide for additional 
instructions. Remove the laser from its box and set it on a stable surface to prepare it for mounting.   

  
Remove the “red” beam cover from the laser. Install Polarizer/Isolator mount with four bolts. Attach 
the polarizer/isolator to polarizer/isolator mount with three bolts.                                                             

                                          
E250 Front                                                               Polarizer/Isolator Mount 

 
 

Lift the laser onto the back of the gantry and gently snug the polarizer/isolator to the shutter block 
entrance. Set laser into place and verify both washers stayed in place at all three bolt mounting 
locations.  Tighten the three bolts into laser block to secure the laser in place. Torque the laser 

12 



 
mounting bolts to 100 in.-lbs. to prevent distorting the mounting feet. Make sure that the laser has 
no movement. 
 
 

 
                                         Polarizer/Isolator Mount to Shutter Block 

 
 
Install the three bolts between the polarizer/isolator to the shutter block to complete the mounting 
of the laser. 
 

                             
                                   Back of J Series Laser 
 
 
Unplug the DC power supply plugs from the outlet underneath the laser table. 
 
Connect the Black (-) and Red (+) power cables from the DC power supply to the laser power 
posts on the back of the laser.  
 
Connect the two DB15 plugs to EXTENDED I/O and REAL TIME I/O connectors. Tighten the screws on 
each side of the connectors to ensure that it will not come loose.  

 
Insert the “Water In” and “Water Out” water lines to the fittings on the back of the laser. The water 
lines circulate cooled water between the laser and chilling unit to prevent overheating. 

 

^ 
Shutter Block 

13 



 
The laser is now installed and is ready for beam alignment. Reconnect the DC power supply plug 
underneath the laser table before powering up the system. 

 
 
 
Chilling Unit 
  

All laser systems of 100 watts or greater will come with a chilling unit for cooling the laser. The 
chilling unit will automatically turn on and off with the main power of the laser system. Please review 
the chiller’s Operators Manual before setting up the chilling unit. 

 
100, 150 & 200 Watt Systems 

  
1. Remove the chiller from its box and place next to the rear of the laser system. 
2. Hook up the water lines from the laser system to the back of the chiller.  The water lines 

should be labeled for connection to the correct inlet/outlet fittings. 
3. Fill the tank with a 1/2 gallon of propylene glycol and top off with distilled water.  
4. Connect the power plug into its labeled outlet on the back of the laser system. 
5. Verify that the circuit breaker on the back of the chiller is in the ON position. 
6. When the system is first powered up, verify that no leaks are present at any of the water 

line fittings or along the water lines. 
7. Refer to the laser’s Operator Manual for proper cooling fluid temperature. 

 
250 Watt System 

  
1. Remove the chiller from its box and place next to the rear of the laser system. 
2. Hook up the water lines from the laser system to the back of the chiller.  The water lines 

should be labeled for connection to the correct inlet/outlet fittings. 
3. Fill the chiller reservoir with 1/2 gallon of the included OPTISHIELD® Plus and top off 

with distilled water. 
4. Connect the power plug into its labeled outlet on the back of the laser system. 
5. Verify that the circuit breaker on the back of the chiller is in the ON position. 
6. When the system is first powered up, verify that no leaks are present at any of the water 

line fittings or along the water lines. 
7. Refer to the laser’s Operator Manual for proper cooling fluid temperature. 
 
 
 
400 Watt System 

 
1. Remove the chiller from its box and place next to the rear of the laser system.  
2. Refer to the chiller’s Operators Manual for connection of the electrical power. 
3. Hook up the water lines from the laser system to the back of the chiller.  The water lines 

should be labeled for connection to the correct inlet/outlet fittings. Mount the supplied 
filter on the chiller unit to prevent particles from getting trapped inside of the laser 
coolant lines. Replacement filters can be purchased from Kern. 

4. Fill the chiller reservoir with 3/4 gallon of the included OPTISHIELD® Plus and top off 
with distilled water.  

5. Verify that the circuit breaker on the back of the chiller is in the ON position. 
6. Connect the remote cable into the ‘Remote ON/OFF’ plug on the back of the chiller. 

Connect the grounding wire underneath one of the nearby bolts. 
7. When the system is first powered up, verify that no leaks are present at any of the water 

line fittings or along the water lines. 
8. Refer to the laser’s Operator Manual for proper cooling fluid temperature. 

 
 
Electrical Panel 
 

The electrical panel at the rear of the laser system must be hooked up by a certified electrician. 
Failure to follow through will void the system warranty. The main power cable is not included and 
should be available from your certified electrician. A complete panel schematic is located inside of 
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the electrical panel. This schematic is strictly to assist the electrician. If a schematic cannot be 
found, please contact Kern for a copy. 
 

 
Air/Assist Gas 
 

Connect 60-95 PSI of clean, dry air from an air compressor to the air quick connector located on the 
back of the laser system. Air must be filtered before it reaches the laser system for both oil and 
water. Recommend 5 micron pre-filter and 0.1 micron filter. Connect optics and knife air tubing to 
optics assembly. 
 
Recommended air supply volume is 3 CFM with a 20 gallon reserve tank. 

 
For metal cutting, assist gases such as oxygen and nitrogen may be used.  Use the same connection 
on the back of the system for connection of these gases as well.  A regulator will be needed on the 
gas tanks and allow for up to 150 PSI of pressure. 
 
Must use separate air lines for compressor air and oxygen/nitrogen to back of laser system. 
 

 
Vacuum System 
 
 Blower Electrical Connection 
 

The blowers included with the laser system operate on 230 volts AC. All LaserCELL systems have 
power outlets on the back for connection of the blowers.  The blower operation can then be 
controlled from the control panel at the front of the laser system. If blowers of different sizes 
(horsepower) are used, the electrical outlets may be labeled for proper connection. 
 
 
Blower Hose Connections 
 
The hosing, metal clamps, extensions, and all other plastic fittings are included to hook up the 
blowers. The exhaust from the blowers must be run through a fume extractor or to the outside of the 
building. This may require the purchase of additional parts. Refer to the Blower Installation in the 
Systems Diagrams chapter for proper installation of the blower hoses/tubes/adapters. 

 
 
Purge Gas 
 

NOTICE! The use of purge gas is required on lasers of 250 watts and greater. It will extend the life 
and reduce cost of ownership of the laser source. If a proper purge gas is not used and maintained 
with routine maintenance the warranty of the laser may be voided. Please contact a Kern technician if 
you have any questions regarding the purge gas system. 

 
The laser system requires a 2.8 lpm (5.8 scfh) flow 
rate of purge gas to the ¼” air push connector 
located at the back of the laser system. If this ¼” 
air push connector is not installed please contact 
Kern for a no charge upgrade kit. 
 
Passing purge gas through the laser head and RF 
power module can prevent component damage by 
creating an internal positive pressure. Also under 
some conditions of high humidity, the laser beam 
can be distorted by optical absorption of the laser 
beam by fluid vapors and optics internal to the 
laser can be permanently damaged. This effect can 
be totally eliminated by use of a proper purge gas. 
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The quality of the purge gas is an extremely important factor for trouble free operation of the laser. 
While the preferred purge gas is nitrogen with a purity of 99.95%, clean dry air (CDA) is also 
acceptable as specified below. 
 
Please refer to the laser owner’s manual for full description of purge requirements for the laser head. 

 
 
Guidelines for Use of Compressed Air for Purge 

 
If nitrogen is not available, the alternative is clean, dry, oil-free compressed air. Compressed air is 
available in many facilities but typically is contaminated with water and oil vapors. The purity 
requirements for the compressed air are: 

 
1. Filtered to remove particles larger than 1 micron. 

 
2. Dried so that the dew point is 18 degrees Fahrenheit lower than the chiller’s inlet cooling fluid 

temperature. 
 

3. Oil free to better than 99.995%. 
 
 
Recommended Purge Gas Configuration

 
 
A pre-filter(s) is recommended to be located before the finer filters to help prevent the finer micron 
filters from clogging in a short time. The following is a photo showing an acceptable purge filter 
setup that is available for purchase from Kern Laser Systems.  
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Whichever filter system is used, it is the customer’s responsibility to ensure the purge gas is being 
filtered to 1 micron or lower and proper routine maintenance is being performed. Due to the 
variation of compressed air configurations that customers have, Kern recommends that a purge gas 
/ filter expert be consulted. This expert can determine the correct filter system needed to obtain the 
purity specifications of filtered to remove particles larger than 1 micron, dried so that the dew point 
is 18 degrees Fahrenheit lower than the chiller’s inlet cooling fluid temperature and oil free to better 
than 99.995%. 

 
If the purge system becomes contaminated at any point please contact Kern’s technical support for 
assistance. Parts of the purge system may have to be replaced. 

 
Routine Maintenance 

 
Routine preventive maintenance is required for the purge gas filters. If filters become clogged they 
will not meet the purity specifications. Maintenance will depend upon the type of purge gas system 
used. Please contact the supplier for specific maintenance instructions. 

 
Laser Setup Purge Use 

 
Purge is required in order to eliminate moisture from the system prior to use. This is required even 
though the system packaging is designed to ship the laser in a ‘dry condition’. Note that system 
purge is required whenever the system has been off for an extended period of time without purge. 
 
Purge the system with nitrogen or clean, dry air for a minimum of two hours. Failure to purge the 
system leaves the system at substantial risk of optics failure.  

 
 
Mirrors and Lenses 
 

Before using the laser system for the first time, alignment of the mirrors is required to align the 
beam through the nozzle. Also make sure that the lens is properly focused to ensure optimal cutting 
and engraving. These procedures are outlined in the System Calibration section of this manual. 
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Height Follower Controller (Optional) 
 

Systems equipped with the metal cutting option will have a Height Follower Control Box that will 
need to be installed behind the left side of the gantry. The control box will slide back into the 
connector. A green plug from the capacitive sensor also plugs into the back of the box. Refer to the 
Metal Cutting chapter for operation of the controller. 

 
K-Vision Controller (Optional) 
 

Systems equipped with the K-Vision camera option will have a K-Vision Control Box installed inside 
of the electrical panel. Refer to the K-Vision chapter for operation of the K-Vision syste 
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All laser system operators or bystanders must completely read this manual to understand the 
operation and safety needed when in the vicinity of the laser system. Knowledge of the controls, 
adjustments and performance of the system is needed to prevent exposure to hazardous radiation 
exposure. All persons that have visible access to that laser system must wear laser safety glasses at 
all times, even when the laser system is not in use. One person must be designated the laser safety 
officer and oversee the operators of the laser system. 

 
 
Daily Startup 
 

1. Walk around the system and check for any obstacles in the way of the motion of the table or the 
motion of the laser. Check also for any water leaks, frayed cords, or anything that does not look 
proper. 

2. Visually inspect the Lexan laser shield for any damage, which could permit a reflection of the beam 
to escape. 

3. Press the START button on the electrical panel for the laser system and vacuum blower. The chiller 
should automatically turn on when you START the laser system. 

4. Cycle the key switch on the KLMC box from “OFF” to “ON”. There will be a 5-second delay before the 
laser will operate. All lights should turn green except for the Laser Enable and DSP Enable. The Laser 
Enable and DSP Enable will turn green once you have started cutting or engraving. To troubleshoot a 
red light, refer to the KLMC section of the Troubleshooting chapter. 

5. The laser system should now be ready to load a file and begin cutting and engraving. 
 
 
EMF Printer Driver 
 

The Kern EMF Printer Driver is compatible with CorelDRAW, Illustrator and AutoCAD LT. The Kern 
EMF printer driver allows for creation of an .EMF file that combines cutting and engraving into one 
common file. The file is created in a folder and then automatically opened into KCAM. To use the 
driver use the following steps: 
 
Open KCAM. Draw a black hairline circle in CorelDRAW. File > Print 
 
Select the Kern EMF Printer Driver and click Print. The EMF file will automatically load into KCAM. 

 
Click on the Setup button to set your speeds and power in the Vector Colors tab. This screen will 
be displayed: 
 

 
             KCAM, EMF Driver 
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Under the color Black, set the speed to 1 Inch/sec and power to 10% to cut this file in the paper. 
Click OK. 
 
Click the Cut button to load the Cut and Engrave Menu. The nozzle air must be turned on for the 
laser to fire. Click the Air On/Off button to turn on the nozzle air and adjust the regulator to 
approximately 20 PSI of compressed air. Check the Cut vector files box and then press Continue to 
start the cutting of the file. The laser head will first align itself to and then move to the file on your 
tabletop. 
 
The motion will pause at the start position of the deer on the table. Next the beam focus can be set 
to the material surface by placing the supplied Kern Laser Spacer. Place the spacer on the top of the 
material to be cut and slowly lower the focus optics down until it gently touches the spacer. Lowering 
of the nozzle is done by loosening the lever on the optics tube. Tighten the lever, remove the spacer 
and press the ENTER key or click Continue on your screen. 
 
Note:  If the metal cutting option is installed, the Height Follower Motor can be powered off and the 
knob next to the optics tube can be used to lower the nozzle down to the spacer. 
 
The system will follow the programmed path at 1 Inch Per Second (IPS) that you previously set in 
the Vector Settings tab, while firing the laser at 10% power. At this speed and power, the system 
will cut the paper. Once the cut is done the laser will return to its home position. 
 

Do not stare at the laser beam in the cut area or permit others to do so. If laser system makes a 
grinding noise or acts out of the ordinary press the Emergency Stop switch and contact a Kern 
technical staff member. 
 
 
Cutting a .PLT file 
 

Open the KCAM software by double clicking the KCAM shortcut on your desktop. 
 
Click the NEW button to clear the screen, then click the first Open icon and select the Deer.plt file 
located at C:\Program Files\Kern\Samples\Deer.plt. 
 
Click Open to load the .PLT file into KCAM. Next click the most right View button to view the extents 
of the file. The screen should appear like this: 
 

 
    Cutting a .PLT file 

 
 

 
Click on the Setup button to set your speeds and power in the Vector Colors tab. This screen will 
be displayed: 
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           KCAM, Cutting a .PLT file 

 
Under the color Black set the speed to 1 Inches/sec and power to 10% to cut this file in the paper. 
Click OK. 
 
Click the Cut button to load the Cut and Engrave Menu. The nozzle air must be turned on for the 
laser to fire. Click the Air On/Off button to turn on the nozzle air and adjust the regulator to 
approximately 20 PSI of compressed air. Check the Cut vector files box and then press Continue to 
start the cutting of the file. The laser head will first align itself to and then move to the file on your 
tabletop. 
 
The motion will pause at the start position of the deer on the table. Next the beam focus can be set 
to the material surface by placing the supplied Kern Laser Spacer. Place the spacer on the top of the 
material to be cut and slowly lower the focus optics down until it gently touches the spacer. Lowering 
of the nozzle is done by loosening the lever on the optics tube. Tighten the lever, remove the spacer 
and press the ENTER key or click Continue on your screen. 
 
Note:  If the metal cutting option is installed, the Height Follower Motor can be powered off and the 
knob next to the optics tube can be used to lower the nozzle down to the spacer. 
 
The system will follow the programmed path at 1 inch per second and 10% power. At this speed and 
power, the system will cut the paper. 
 
Once the cut is done the laser will return to its home position. 
 
Do not stare at the laser beam in the cut area or permit others to do so. If laser system 
makes a grinding noise or acts out of the ordinary press the Emergency Stop switch and 
contact a Kern technical staff member. 

 
 
Engraving a .TIF file 
 

Open the KCAM software by double clicking the KCAM shortcut on your desktop. 
 
Click the New button to clear the screen, then click the first Open icon and select the Plane.tif file 
located at C:\Program Files\Kern\Samples\Plane.tif. 
 
Click Open to load the .TIF file into KCAM. Next click the most right View button to view the extents 
of the file. The screen should appear like this: 
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                                       Engraving a .TIF file 

 
Click on the Setup button to set your speeds and power in the Image Settings tab. This screen will 
be displayed: 
 

 
                 KCAM, Engraving a TIF file 
 
 
Set Laser power for black between 10-25% and your Engraving Speed to 40”/sec. Click OK. 
 
Click the Cut button to load the Cut and Engrave Menu. Make sure you have air coming out of the 
laser nozzle by clicking the Air On/Off button and adjusting the regulator to approx 40 PSI of air. 
Check the Engrave image files box and then press Continue to start the engraving of the file. 
 
The laser will first home itself and then move to the file on your tabletop. 
 
The motion will stop at the position of the airplane on the table. This will allow you time to set the 
focal point by placing the laser spacer on the top of your material and slowly lowering the focus 
optics down to the spacer. Now press the ENTER key or click Continue on your screen. 
 
The system will engrave the programmed path at 40 IPS that you previously set in the Image 
Settings tab, while firing the laser at 25% power. At this speed and power, the system will engrave a 
piece of wood. 
 
Once the file is done the laser will return to its Home position. 
 
If laser system makes a grinding noise or acts out of the ordinary press the Emergency 
Stop switch and contact a Kern technical staff member. 
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New systems come fully tested and calibrated from the Kern factory. It is necessary to check the 
beam alignment of your system upon initial setup of the laser system. Please refer to the System 
Diagrams section of this manual for optics and mirror alignment diagrams. 

 
 

Mirror Alignment  
 
To align the flying optics assembly on your laser system you will need the following: 

   
• Masking tape and Teflon tape. 
• 7/64”, 1/16”, and 3/32” Allen wrenches. 
• Aluminum alignment disks. 
• Alignment sheet at the back of this manual. 
• A small piece of wood approximately 4” x 4” and thicker than 1/4”. 

 
Instructions for checking and adjusting the alignment of your optics mirror are as 
followed: 

 
1. Open the manual screen in KCAM. 
2. Set the power level to 25%. 
3. Place the large alignment disc at Stage 1(refer to the Mirror Alignment diagram in the 

System Diagrams chapter). 
4. Place a piece of masking tape over the disc. 
5. The doors and windows must be closed for the laser beam to operate. 
6. Turn on the air and fire the laser with an “on time” of .5 seconds. 
7. Adjust the laser mounting by positioning the laser to burn the center of the disc. 
8. Place the small alignment disc at Stage 2. 
9. Turn on the air and fire the laser. 
10. Remove the top metal plate at Stage 1 with a 7/64” Allen wrench. Loosen the set screws 

with a 1/16” Allen wrench. Adjust the mirror cap screws with a 3/32” Allen wrench to center 
the burn into the alignment disc.  

11. Lightly screw the set screws back into place without tightening too far to adjust the 
alignment of the mirror.  

12. Replace the top metal plate. 
13. Fire the laser once again to make sure the mirror is still aligned. 
14. Drive the optics down the rail to the far end and place the small alignment disc at Stage 3.  
15. Place masking tape over the disc. 
16. Turn on the air and fire the laser. 
17. At Stage 2 loosen the set screws with a 1/16” Allen wrench. Adjust the mirror cap screws 

with a 3/32” Allen wrench to center the burn into the alignment disc. 
18. Lightly screw the set screws back into place without tightening too far to adjust the 

alignment of the mirror.  
19. Fire the laser once again to make sure the mirror is still aligned. 
20. Remove the optics nozzle from the assembly and lower the laser tube so that it covers one of 

the crosshairs on your Beam Alignment diagram (in the back of manual).  
21. Raise the optics tube 3 inches above the alignment sheet. Make sure to keep the wood block 

steady so that it stays directly centered below your optics. 
22. Fire the laser at 5-10% power and observe where the laser beam has hit the alignment 

sheet. If it is centered on the crosshairs no further alignment will be needed. If it is not 
exactly centered you will need to adjust the alignment of your optics mirror at Stage 3 to 
burn the center of the crosshair. 

23. Reinstall the optics nozzle back onto the laser tube.  
24. Place Teflon tape over the laser nozzle. 
25. Fire the laser at 5 -10% power and observe where the beam is leaving the nozzle with your 

mirror tool. The hole in the Teflon tape should be very small like a pin prick. If it is larger 
than this you may have clipping and need to further adjust the mirror. If it appears centered 
coming out of the nozzle then your mirror is properly aligned. If it is not centered then 
further adjustments to the mirror will be needed. 
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26. Click the close button or the ESC key to get back to your regular KCAM screen. 

 
NOTE: The optics tube assembly should not get hot. If it does, that may indicate your beam 
is clipping inside the optics assembly. The above procedure may be needed to correct the 
beam alignment. 

 
 
Focusing the Optics 

 
A lens focuses the laser beam to a very small invisible point of light. This point of light is very 
intense in temperature and will vaporize many materials. The lens has a focal point or focal length. 
This is the distance from the center of the lens to its smallest spot. 
 
Focal lengths (FL) that are commonly used are 1.5”, 2.5”, 5.0” and 7.5”. 
 
The optics nozzle will come focused from our factory. If for some reason the optics loses focus you 
will need to cut into a piece of paper or wood at 1 inch per second and 10% power. Follow these 
steps: 
 
1. Open Test Mode in KCAM. 
2. Lower the nozzle and use the Kern Laser Spacer to focus the nozzle to the paper. 
3. Make sure you are cutting with shop air and NOT oxygen when setting the focus height. 
4. Cut into the material and drive the laser in one direction. Adjust the nozzle up or down until you 

have the narrowest line in the material. When you are cutting with the narrowest line width this 
is when the focus height is set. 

5. If your narrowest line is at the same distance of the Kern Laser spacer you are in focus. 
 

Adjusting the lens to get back into focus: 
 

1. Unhook the air hose from the laser nozzle. 
2. Remove your laser optics nozzle from the laser system. 
3. With your lens removal tool unscrew the first black lock ring screw. 
4. Gently remove the lens from the assembly, place on a clean cloth. 
5. Remove the O-ring. 
6. Adjust the bottom black lock ring up or down depending on where you need to get in focus.  
7. Place the O-ring back into the optics. 
8. Gently place the lens back into the optics. 
9. Screw the top black lock ring back into the optics and gently snug to the lens. 
10. Hook up the air hose and screw the laser nozzle back into the laser tube. 
11. Cut the file again and verify that the narrowest cut on the paper is at a width of the Kern Laser 

Spacer. 
12. Begin laser operation if the focus is now correct. Readjust the bottom black lock ring if you are 

still out of focus. 
 

 
Squaring the Table 
 

1. Open Corel Draw. Draw a hairline box “see diagram” about 75% of your table size in the center 
of the table.  

2. Use the Virtual Segment Delete tool to keep just the corners. 
3. Print to Kcam and cut file on paper with vacuum on. 
4. Measure corner to corner diagonally. If the cut is not square, loosen the three bolts on each side 

of the gantry and adjust the limit switch on the right side of the machine. Retighten the (3) 
bolts, realign the system, cut the file and measure again. Repeat until cut is square. 
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     Only black corners 

 
 
Setting Zero-Zero Point 
 

The objective is to align the laser to have the 0, 0 reference point in the lower left corner of the 
table, inside the aluminum frame. The 0, 0 point is set at the factory. It is a good idea to test this 
when receiving your laser system. Follow these steps: 
 

1. Open KCAM 
2. Open the Match1000.plt file at C:\Program Files(x86)\Kern\Samples\Test 

Files\Match1000. 
3. Place file in zero corner of table by selecting Setup\Misc. Settings. Check User Offset box 

enable and set X and Y to -3. Verify Page Lower Left (default) is applied.  
4. Cut the file out of the table top paper.  
5. The box should be flush with the front and left rail. 
6. If it is not flush go to the Table tab in Table Settings and adjust the Alignment offset 

distance until the square is flush with both aluminum rails. 
 
 
Aligning the Engraving Pixels “Dot Calibration” 
 

These parameters are set at the factory before shipping the system. Normal wear of the belts and 
pulleys may require realigning. 
 

 

STEP 1  The first step is to create a .TIF file in CorelDraw.  To do this, open CorelDraw.  Select the freehand 
tool from the left toolbox.  Draw a vertical line on the table 10 inches in length.  With the line 
selected that was just created, go to Edit Step and Repeat.  Enter 375 for the number of copies 
and select Offset under the Horizontal settings.  Enter a distance of .125.  Under Vertical settings, 
select No offset then click Apply. 
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Step and Repeat 

 

 

STEP 2  Go to File Export.  Select a location to export the file to and give the file a name (Example: Test 
60).  The save as type must be a .TIF file and the sort type must be Bitmap.  Click on Export.  A 
second screen will appear.  Maintain original size needs to be checked and the color mode must be 
black and white.  The resolution needs to be 60 dpi.  Once done, click OK. 

 
Save as type 

    

26 



 

  
Export 

 

 

STEP 3  Open KCAM.  Select the first open button located in the upper left corner.  Locate the .TIF file just 
created.  Click open. 

  
Open 

 

 

STEP 4  With the file opened, click on Setup Image Settings.  The pixels per inch need to be set at 60 for 
both the X and Y.  Set the speed to 10 inches per second and the power for black at 10%.  Next click 
on Misc. Settings and enable the user offset.  Move the file up and over from zero, zero (Example: 1 
and 1) Click OK. 
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Image Settings 

 

 
Misc Settings 

 

STEP 5  Click on Cut at the top of the screen.  With this screen open, make sure engrave image files is 
checked.  Once checked, click Start. 
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Cut 

 

 

STEP 6  After the machine has engraved a couple passes, pause the machine at the end of a line.  With a 
magnifier, look at the dots.  The middle half to two thirds of the table should be vertically lined up.  
If they appear to be offset, click on Table Settings Tuning.  The setting that needs to be adjusted is 
the Belt Windup Adjustment. (This number can be negative or positive and has a range of +/- 4).  
Start by entering -.5.  Click OK and continue.  Recheck the dots.  If the dots are still offset, continue 
to increase/decrease the Belt Windup Adjustment. 

   
Tuning 
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STEP 7  Once the dots are lined up at 10”/sec, increase the speed to 150”/sec and power to 60% (Use 

130”/sec for Metal Cutting head).  Continue the engraving.  After a couple passes, pause at end of 
line.  Look at the first 12 inches or so on both the left and right sides of the table.  The dots will 
appear offset from each other, but also the rows that were made at 10”/sec.  To align the row of 
dots made at 10”/sec to the dots made at 150”/sec, go to Table Tuning Ramp Offset Distance.  
The left box controls the left side of the table and the right box controls the right side of the table 
(The numbers will be positive and have a range of 0 to 10).  Start by entering 1 in both boxes.  
Continue the engraving.  After a couple passes, check the dots.  Either increase or decrease the 
Ramp Offset Distance to align the rows of dots made at slow speed to the rows of dots made at fast 
speed.   

NOTE: The left side may have a different number entered than the right side. 

 

  

  
Tuning 

 

STEP 8  Next, move to the middle portion of the table.  The dots will look offset to each other, but should 
appear lined up with the dots made at 10”/sec.  Click on Table Settings Tuning Laser Delay.  
Start by entering -60 (This setting is typically negative and ranges from 0 to -100).  Click continue.  
After a couple passes, check the dots. Either increase or decrease the Laser Delay to align the dots 
in the middle of the table at fast speed. 

STEP 9  If the first row of dots on the far left and right are not lined up, (If first row on left and right look 
good, skip to STEP 10) go to Table Tuning Ramp difference.  The left box controls the left side 
of the table and the right box controls the right side of the table (This setting has a range of +/- 2).  
Start by entering .1 for both boxes.  Click continue for the engraving.  After a couple passes, pause 
at end of line and check the outside dots.  Slowly increase/decrease the Ramp difference until the 
outside left and right dots are aligned. 

Rows at 
150”/sec 
Rows at 
10”/sec 
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NOTE:  The left side may have a different number entered than the right side. 

 

STEP 10  Lastly, align the dots on the left and right sides of the table, minus the first row on the left and 
right sides.  Click on Table Settings Tuning and enable Fine Tuning. The first four boxes control 
the left side of the table and the next four control the right side of the table.  The numbers entered 
here can be positive or negative, whichever makes the dots align.  The first box controls 
approximately the first three inches.  The second box controls the next three inches.  The third box 
controls the next three inches passed the second and the fourth box controls the next three inches 
passed the third.  All in all, the Fine Tuning controls approximately the first twelve inches on both 
the left and right sides of the table.  If too large of a number is entered into one of the boxes, it will 
affect dots outside of its specified area.  Each box has a range of +/- 5.  Numbers outside this 
specified range can cause the motors to hum or make irregular noises.  Check the box next to mark 
ramp points by shading.  Click Ok and continue the engraving.  After a couple passes, pause the 
system at end of line.  There will be shaded regions on both the left and right sides of the table.  
These shaded regions correspond to where the Fine Tuning boxes will be effective.  Uncheck the 
mark ramp points by shading.  Begin by entering a number in one of the boxes and see how it 
affects the dots.  Adjust the numbers in each of these boxes to get the dots to align.  The goal is to 
get the dots to line up as vertical as possible. 

 

  
Tuning 

 

NOTE:  Not all the boxes may be needed.  Numbers may differ from the left side of the table to the 
right side. 
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STEP 11  Once dots look acceptable, engrave a file to verify results. 

                Without Fine Tuning     With Fine Tuning 

 

 

      

 

NOTE:  If any difficulties occur in aligning the dots, contact Kern Electronics & Lasers Inc. at 1-888-
660-2755 and a technician will assist you. 
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The KCAM software will be preinstalled on your laser system computer. All parameters for the KCAM 
software and servo motors are saved on a USB stick in your laser tool kit. Kern has also backed up 
these parameters at our facility. 

 
Installation 
 

The KCAM software is available online at http://www.kernlasers.com/customer-login. If you do not 
have a username and password please contact our technical support team to receive one. 

 
 
Upgrades 
 

Updates are periodically available for the KCAM software. Please give notice to the fine print on the 
download page as certain upgrades may require you to do a full reinstall rather than just placing the 
upgrade file into the KCAM7 folder. 
 
To locate your current KCAM version number select the ‘Help’ tab at the top of the KCAM screen and 
select ‘About KCAM7’. 
 
 

Overview 
 

KCAM is a Windows based motion and laser control program created by Kern’s software engineering 
department. The image below is the main screen of KCAM7. KCAM can directly open .TIF (raster), .PLT 
(vector) and .EMF (combined raster and vector) files. The Kern EMF Printer Driver can be used to print 
from software packages such as CorelDRAW®, AutoCAD LT® and Adobe® Illustrator®. 

 

 
  Opens .PLT (vector) and .TIF (raster) files. 

 
  Opens .EMF (combined vector and raster) files.  

 
  Clears all open files from the preview screen. 

 
  Opens a text notepad for saving notes. 

 
  Displays the entire table. 

 
  If an array is set, this option will show the extents of the entire array. 

 
  Displays the extents of the opened file. 

 
  Opens Setting menu. The speeds and power levels are set here. 

 
  Opens Table menu. Options in this menu are preset for your system. Please DO NOT edit these 
settings without consulting a Kern technical staff member. 

 
  Opens the Time Estimator, File History, Process Log and System Usage tab. 
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  Opens the Cut and Engrave status menu. This menu allows you to start cutting and/or 
engraving. 

 
  Opens the Manual Test screen. This screen allows you to manually fire the laser and run the 
motion of the laser system. 

 
 
File 
 
New: Clears all open files on the table preview. 
 
Open: Opens .PLT (vector) and .TIF (raster) files. 
 
Import EMF files: Opens .EMF (combined vector and raster) files. 
 
Exit: Closes KCAM 
 
 
View 
 
Notes: Opens a notepad for you to enter information on the files you are cutting and engraving, 
such as material, power, speed, etc. 
 
Normal preview shader: Default setting for viewing table. 
 
Fast (darker): Loads larger images faster and with less resolution. No resolution is lost in the actual 
cut or engrave file. 
 
View glass or granite errors:  Errors in your raster file are highlighted. Errors could be caused 
from using a different software design DPI compared to the DPI you printed to KCAM at. 
 
Invert Image Colors: Inverts colors in previewer. 

 
Draw lines as dashes, Show line nodes, Show Grid: Miscellaneous viewing options. 
 
Zoom Table: Displays the entire table top. 
 
Zoom Array: If an array is set the extents are shown. 
 
Zoom Extents: Displays the extents of the open file. 
 
Toolbar and Status Bar: Hides or displays these two bars. 
 
 
Settings 
 
Edit Setting: Opens Setting menu. The speeds and power levels are set here. 
 
Edit System and Table Settings: Opens Table menu. Options in this menu are preset for your 
system. Please DO NOT edit these settings without consulting a Kern technical staff member. 
 
Lock Settings: Password protects various aspects of KCAM. 
 
 
Actions 
 
File Time Info: Opens the Time Estimator, File History, Process Log and System Usage tab. 
 
Cut and Engrave: Opens the Cut and Engrave status menu. This menu allows you to start cutting 
and/or engraving. 
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Activate on "Enter Key": Allows cutting and engraving to start by pressing Enter key. 
 
Manual: Opens the Manual Test screen. This screen allows you to manually fire the laser and run 
the motion of the laser system. 
 
Table Map: Mapping program to increase table accuracy. These settings are preset and should not 
be adjusted without the help of a Kern support technician. 
 
Tcp Control: Used for Kern technician troubleshooting. 
 
Debug/Scope Windows: Used for Kern technician troubleshooting. 
 
 
Help 
 
KCAM7 Help Contents: Brings you to the top of the Help page. 
 
Online Help: Sends you to the Kern Technical Support page. 
 
About KCAM 7:  Displays details on the version of KCAM you are running. 
 

 
Setup Icon 

 
Vector Colors Tab 
 
The Vector Colors tab is where you set cutting power levels, speeds, modulation mode and to 
enable/disable up to 9 different colors of vector lines. 
 
 

 
                  Vector Colors 
 
 
Enable (Colors) 
 
The checkboxes to the left of the colors list will enable or disable its corresponding vector line color. 
 
All/None: Allows you to quickly enable or disable all colors. 
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Speed 
 
Vector cutting speeds for nine different colors can be set in the Speed column. The range of 
acceptable speeds is from .01 inches per second to 10 inches per second. 
 
 
Laser Power 
 
The laser power level for each color can be adjusted from 0 to 100%. 
 
 
Density 
 
The density is measured in Joules. This is used as a reference for matching different speed and 
powers. 
 

 
Modulation Mode 
 
One of two modulation modes can be set: 
 

Laser Modulation Frequency   
Setting Range:  50 – 10000 Hz.  
Default Setting:  5000 Hz  

 
Pulses Per Inch  
Range:  0 – 600 pulses. 

 
 
Laser Start % 
 
Adjust the laser start for individual line colors. This setting will affect the power of the laser when 
ramping in corners and arcs. It will adjust the minimum laser power from 0 to a value that will cut 
through in the corners. 

 
 
Tool Offset 
 
Offsets the cutting line to the inside or outside of the original file. 
 
 
Load/Save Settings 
 
Load Settings: Loads saved cutting and engraving parameters. 

 
Save Settings: User defined parameter list. Once cut and engrave parameters are optimized for a 
material, the Save Settings tab can be used to save the current parameters as a unique name.  This 
allows past parameters to be accessed for future use. 

 
 
Vector Settings Tab 
 
The Vector Settings tab is where you can set various cutting delays and other options.  
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                         Setup, Vector Settings 

 
 
Laser 
 
Pierce Start Delay:  Sets a delay which will give the laser a chance to penetrate the material to be 
cut. This setting should be left at 0 for normal operation. This setting is typically used when cutting 
thicker materials and metal cutting applications. The two boxes to the right allow the laser power % 
and frequency to be set to a custom level during piercing.  
 
End Delay:  Sets a variable pause which will give the laser a chance to ‘catch-up’ with itself at the 
end of a cut. This setting should be left at 0 for normal operation. This setting is typically used when 
cutting thicker materials and metals. 

 
Height Follower Delay:  A delay that allows the height follower to move up or down into position 
when starting or finishing a cut. 

 
Laser Curve:  Controls the laser power between the Laser % when starting and stopping and the 
set laser power. A laser curve of 0 will map the power levels in between linearly. A laser curve of 1 
will use a curve with a power of two (a = b ) .  Default is .9. This feature is used mostly when cutting 
partially into materials to give you desired cutting depth in the corners and on straight lines. 
 
Nozzle Air Control:  Enable Air 1 and Air 2 during different settings. 
 
 
Lead in Control 
 
Enable: Turns ON and OFF the Lead-In Control. This will allow you to cut at a slower speed for a set 
distance. 
 
Distance: Distance the lead-in is effective for. 
 
Speed: Speed to go for this lead-in distance. 
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HPGL File Size and Placement 
 
Steps Per Inch:  Match this setting to the output setting of your design software. Typically set to 
1000. 
 
X left origin and Y bottom origin:  Moves the placement of your file on the tabletop. 
 
Example: Set X left origin to 5 and Y bottom origin to 5 and all vector images move up and over 5 
inches from its present location. Negative numbers will move the file in opposite direction. 
 
 
Cutting Optimizer 
  
Enable: When checked, this feature will cut the line segments of your file in a way that will minimize 
the time needed to complete the file (must reload file to activate). 
 
Sort by color:  Cuts all vector lines of one color before moving onto the next color. 
 
Allow lines to be reversed:  Will reverse vector cutting direction if calculated as a faster 
alternative. If you are cutting a material where lead-ins are used you may want to disable this 
setting. 
 
Cut outside lines last:  Cuts out the inside pieces of your file first. This will ensure that your 
material does not shift while cutting the smaller pieces inside your main cut profile. 

 
 
Cut Options 
 
Reverse Cut Order:  Reverses the part order during cutting.   
Example:  Parts are normally cut in order of A, B, C. When this option is checked the order the parts 
are cut is now reversed to: C, B, A. 
 
 
Line Smoothing 
 
Enable corner fillets:  Extra nodes added to arcs allowing for smoother cut edges. This is very 
noticeable in acrylic (must reload file for changes to take effect after this setting is checked). 
 
Maximum angle:  The maximum angle of a curve before the software will add nodes. This setting 
decides if smoothing will be used based on the setting here. Typically set to 30. 
 
Maximum allowed error:  The allowable error. Typically set between 0.5 & 1.0 mil. 

 
Maximum arc length:  Smoothing in corners. 
 

 
Vector Path Speed Control 
 
These numbers relate to the ramping of the machine when it approaches corners, circles and radiuses. 
It is a very helpful setting to reduce vibration in these areas. 
 
Stop if angle is greater than:  This refers to a change in angle of a vector cut.  If the machine 
recognizes a change in angle of the number entered or greater, it will stop for a brief moment and 
then continue its cut. 
 
Slow down if the angle is greater than:  When performing a vector cut and the machine comes 
to an angle that is greater than the angle entered, it will slow down to the speed entered in the slow 
speed setting. 
 
Example: If an angle of 10 is entered in the Slow down if angle is greater than box and .2”/sec is 
entered in the Slow speed box, than each time the machine recognizes a change in angle of 10 
degrees or more, it will slow to .2”/sec. 
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Slow speed: Each time the machine slows down for a change in angle, it will slow down to the 
speed entered here. This speed can range from .01 to 10 inches/sec.  The intricacy of the cut will 
determine the speed entered. The more intricate, the slower the speed needs to be set. 
 
Stay Slow for:  When the machine enters a corner or a radius, it will slow to the speed entered in 
the slow speed setting. As it comes out of the corner or radius, it will stay at that slow speed for the 
distance that is entered for this setting. 
 
Example: The machine is cutting a 0.25” radius on a part and the Stay slow for is set at 0.2”  
and the Slow speed is set at 0.4”/sec. The machine will slow to the 0.4”/sec for the radius  
and will keep that speed for a distance of 0.2” passed the radius. 
 

 
Image Settings Tab 
 
The Image Settings tab is where you can set engraving laser power, engraving speed, 
scanning options and a user offset. 
 

 
          Setup Menu, Image Settings 

 
 
Engraving Power 
 
Laser power for black: Black represents full power, or 100%. Laser power for black can be set 
from 0 - 100%. 
 
Laser power for white: White represents no power, or 0%. Typically set to 0%. 

 
Laser Start: This setting adds additional laser power when the laser is ramping up or down in speed 
(edges of your file).  
 
Example: Your marble etching is coming out good but a little dark on the outsides. Increase this 
number to laser the outsides with more power. For most materials this number is left at 3%. Typical 
setting is from 0 - 60. 
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Laser Curve: Controls the laser power between the Laser Start and the black laser power. A laser 
curve of 0 will map the power levels in between linearly. A laser curve of 1 will use a curve with a 
power of two (a = b2). Most materials use a laser curve setting of 0.8. 
 
 
Image Size and Placement 
 
When you export a .TIF file from the design software, you can select the image DPI. This same DPI 
must be set in KCAM to match your drawing. Set your DPI (dots per inch) in KCAM by setting pixels 
per inch: in the X-axis and lines per inch in the Y-axis. 
 
NOTE: The DPI is automatically set for you if you are using the Kern Printer Driver. Your image will 
be saved from your design software and opened in KCAM with the correct DPI. The DPI is set in the 
EMF Import tab. 
 
Offset from left and offset from bottom: Shifts the open image anywhere on the table top. 
 
Example: Setting the X and Y offsets both at 5 will move the image towards the back 5 inches and to 
the right 5 inches. 

 
 
Engraving Speed 
 
Sets the raster engraving speed of the laser system. 
 
Engraving Speed Chart 
 

Engraving Speed Chart 

System Model Min Speed Max Speed 

 LaserCELL .1”/sec 150”/sec 
 LaserCELL w/ metal cutting .1”/sec 130”/sec 

    Engraving Speed Chart 
 
 

Ramp Distance:  This feature sets the travel distance off the right and left edge of the engraving. 
Typical setting is 0.5”. 
 
Example: If engraving a 5 inch wide box with the ramping set at 1”, the laser head will travel 1” past 
the extents of the engraving file on both left and right. This is helpful to get the laser up to speed on 
small parts so that the laser is firing when the head is at a constant speed. 
 

 
Scanning Options 
 
Fixed Width:  The laser will scan out to the width of the files furthest extent.  
 
Average width:  Similar to Fixed Width, except that the laser nozzle will gradually move in with the 
file if it gets narrower. 
 
Start at bottom and engrave upwards: When checked, the laser starts engraving from bottom of 
the image and finishes at the top. 
 
Single Direction: This option allows the laser to engrave left to right and traverse back without 
firing the laser from right to left. This can eliminate banding in some instances. 
 
Enable Height Follower while engraving: When checked, the Height Follower will be active while 
engraving. (When enabled, maximum engrave speed of 20” per second) 
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EMF Import Tab 
 
This tab lets you choose the path in which your EMF files are saved to, and the DPI of your file. 
 

 
           Setup Menu, EMF Import 
 
 

Win 2000/XP EMF Printer Driver Settings 
 
This menu will be displayed when you click the Edit button. Here you set your DPI, table size, and 
output location. 
 
 

               
                  Setup Printer 
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Number Files: Check to name each file with a specific time. 

 
The code behind the save name is: 
 
Example: Plane.cdr_20080408135603_EMF.EMF 
 
Plane.cdr = name of the file 
2008 = year 
04 = month 
08 = day 
13 = hour 
56 = minute 
03 = second 
EMF =file type 
.EMF = file extension 

 
Output location: This must be set to:   
C:\My Documents\KcamEMF 
 
 
EMF Converter Settings 
 
When checked, will automatically save your files with the selected X and Y DPI. Both DPI’s must be 
increments of the DPI in the table section above for best results. If split, X=600 and Y=300, the X 
would have twice the resolution while keeping the engraving time in the Y axis to half or 300 lines 
per inch. For best results use the same DPI for the X and Y. 
 
NOTE: It does not matter what Kern Printer Driver you select when this is checked, you will always 
print at the DPI entered here. When you uncheck this box the Kern Printer Driver from the Win 
2000/XP EMF Printer Driver Settings section will take effect. 

 
 
Post Processor (k-vision) 
 
This section is only used if the k-vision camera system is installed and being used. Please call a 
KERN technical support member for correct settings. 
 
 
Misc Settings Tab 
 
The Misc Settings tab lets you set a user offset, create an array, set a soft home position and set a 
variety of pauses. 
 

 
                              Setup Menu, Misc Settings 
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User Offset 
 
Enabled: Allows you to move your vector and images file in the X and Y direction. 
 
By typing a positive number, you can move artwork from the left side of the table to the right side of 
the table in the X direction. By typing a negative number, you can move artwork from the right side 
of the table to the left side of the table in the X direction. 
 
By typing a positive number, you can move artwork from the front side of the table to the back side 
of the table in the Y direction. By typing a negative number, you can move artwork from the back 
side of the table to the front side of the table in the Y direction. 
 
This feature can be used with any file type, .TIF, .PLT or .EMF. If left checked all future loaded files 
will have this offset. 
 
 
Array 
 
Enabled: Allows you to make copies of a single file across and up or down the table. To use the 
Array feature you must enable array on the Cut and Engrave Menu. 
 
X and Y distance per step: Determines how far, in inches the files are spaced apart. 
 
Row at once: If checked will engraves all images as one (faster). If unchecked, engraves each 
individual part separately in the array. 
 
X and Y Count: Number of copies you want in each direction of the array. 
 
 
Soft Home Distance 
 
By default when a job is completed the laser system will return to the back, left home position. If a 
soft home distance is entered the laser will now move back behind your file and not go completely 
home. This will decrease travel time between cuts. 
 
 
Automation 
 
Pause at start before moving out to part: Pauses at the home position before moving out to the 
part. 
 
Pause just before first line: When the laser has moved out of its home position and ready to 
cut/engrave, it will pause at the start of the file. This pause is used when you want to adjust the 
focus point with your spacer. Systems are sent out with this pause on. If the pause is unchecked, 
the laser will start to engrave or cut as soon as it is at the start of the file. 
 
Pause before each color change: If you have vector lines of different colors, the laser pauses 
before cutting the next colored line. 
 
Pause before the first cut of each array part: If you are cutting an array of parts, the laser 
pauses before each part. 
 
Pause before each repeat: The laser pauses before each repeat of a file. The Enable Repeat box 
must be checked on the Cut and Engrave Menu. 
 
Pause before moving home after last line: When the laser has finished engraving/cutting, the 
laser will pause before moving home. 
 
Example: If you need to engrave inside an object like a box that has 2” edges, use the Pause just 
before first line to set your focal point down inside the box. Then use the Pause before moving home 
after laser line to raise your optics back up to clear the 2” edge. 
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Table Icon 

 
All table settings are calibrated at the factory.  Contact Kern before making any changes to these 
parameters.  Some adjustments may cause damage to the laser system. Please DO NOT exceed the 
maximum speeds listed below. The warranty of the system and laser will be voided if maximum 
speeds below are exceeded. 
 
Speeds Tab 
 

NOTE: CONTACT KERN SUPPORT FOR CORRECT SETTINGS 
 

        
                Table Settings, Speeds 

 
 
Maximum Speed: Sets the maximum speed that the motors will move in the X and Y directions.  
These numbers are set at the factory.  If these numbers are set higher than the factory defaults, 
errors or malfunctions of the motors may occur.  

 
Engraving Acceleration: Sets the acceleration rate for engraving. 
 
Engraving Jog Speed: Sets the jog speed for engraving. 

 
Cutting Acceleration: Sets the acceleration rate for cutting. 

    
Jog Speed: Sets the speed while moving between parts. 

 
Jog Acceleration: Sets the acceleration rate for the jog speed. 

 
Align Speed: Sets the align speed back to the limit switches. 

 
Align Acceleration: Sets the acceleration rate for the align speed. 

 
 

Vibration Reduction 
 
Jerk reduction plays a role in both vector cutting and raster engraving.  “Jerk” reduction delay and 
Delay after a Jog are measured in milliseconds.  By increasing these two numbers, it allows the 
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motors to have a slight delay between accelerating and decelerating.  In Vector cutting, it will make 
smoother cuts and in Raster engraving it will allow for crisper images. The max this number can be 
set to 100. 
 
Slow down on curves 
 
When enabled, allows for smooth transitions when cutting square corners, arcs and radiuses. 
 
Tuning Tab 
 
This section is for aligning your system when it is raster engraving. Please refer to the System 
Calibration section of this manual for complete instructions on how to perform the dot alignment 
test. 

                      NOTE: CONTACT KERN SUPPORT FOR CORRECT SETTINGS 

           
             Table Settings, Tuning 

 
 
Feed Forward (For Mechanical Effects) 

 
Backlash Distance: Not currently used. 
 
Speed Rate Offset: Not currently used. 
 
Ramp Offset Distance: Used for the dot alignment, but at a speed of 130 inches/sec or 150 
inches/sec, depending upon if the metal cutting option is prevalent. This offset adjusts the lines 
when switching from a slow speed to a fast speed on both the left and right sides of the table as the 
laser head is accelerating. 

 
Ramp Difference: The Ramp Difference will align the dots on the left and right sides of the table. 

 
Belt Windup Adjustment: This setting is used for aligning the dots when performing a dot 
alignment test. The dot alignment test is done at the factory, but may need to be done by the 
customer if they have changed a laser or mechanical part. The distance offset is used to align the 
dots at a slow speed (10”/sec).  This number should affect the dots the full width of the table. 
 
Windup Runout Distance: Call Kern 
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Laser Timing vs. Motion 
 
Laser Delay: The laser delay will align the dots in the center of the table when switching 
from a slow speed to a fast speed. It delays the firing of the laser to match the motion of 
the machine. It’s measured in microseconds. This setting has a range of 0 to -100.  This 
number will vary on each laser that is mounted, regardless if it’s the same wattage or not. 

 
Motion Delay: Not currently used. 
 
 
Feed Forward for Motor Effects 
 

 Distance at speed: Not currently used. 
 

Ramp Distance: Works together with Ramp Offset Distance. 
 
Delay: Works together with Fine Tuning.  

 
 

Feed Forward Fine Tuning for the X Axis 
 
Ramp difference: This setting is used to fine tune the dots on the outer left and right sides of the 
table at a fast speed. The numbers entered here can be positive or negative, whichever makes the 
dots align. The first box controls approximately the first three inches.  The second box controls the 
next three inches. The third controls the next three inches passed the second and the fourth controls 
the next three inches passed the third. All in all, this setting controls approximately the first twelve 
inches on both the left and right sides of the table.  The right side of the table works the same as the 
left.  If too large of a number is entered into one of the boxes, it will affect dots outside of its 
specified area. A number shouldn’t be entered larger than 10 or smaller than -10. Numbers outside 
of this range can cause the motors to hum or make irregular noise. These numbers are set at the 
factory and should not be changed unless any parts or a laser has been changed on the machine. 
 
Time to Middle: The time to middle will either increase or decrease the effective area of the fine 
tuning numbers. The larger the number entered, the larger the effective area.  This setting has a 
range of 0 to 30 milliseconds. 
 
 
Lasers Tab 
 
               NOTE: CONTACT KERN SUPPORT FOR CORRECT SETTINGS 
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                 Table Settings, Lasers 

           Laser Timing  
 
Actual Laser Wattage: The actual wattage of a laser after being checked with a power meter is set 
at the factory. Not to be changed unless the laser tube is replaced. 
 
Reference Laser Modulation: The modulation duty cycle of the laser mounted on the machine is 
entered here. This is set at the factory.  The software will reference the percentage entered in both 
Vector cutting and Raster engraving to this number. Not to be changed unless a different laser is 
mounted. If you get a SWR alarm try lowering the modulation by 1% and see if the alarm goes 
away.  

 
Maximum Laser Modulation: This setting will limit the lasers duty cycle on the Laser System to the 
entered modulation percentage. A SWR alarm may occur if this setting is not correct. If you get a SWR 
fault try lowering the modulation by 1% and see if the alarm goes away. This is set at the factory and 
should not be changed unless a different laser is mounted. 
 

 
Maximum Pulse Length: This setting is not used at this time. 

 
Tickle Frequency: The tickle frequency helps excite the laser so it will fire quicker. This frequency 
should match the laser modulation frequency. Not all lasers require a tickle frequency, some may 
have a built in tickle. 

 
Tickle Pulse: The tickle pulse is used to help keep the gas inside of the laser ionized. This setting is 
preset at Kern. The default value is 500. 
 
 
Table Tab 
 

    NOTE: CONTACT KERN SUPPORT FOR CORRECT SETTINGS 

              
    Table Settings, Table 

 
 
Table Size 
 
Table size: This relates to the actual cutting area of the machine in inches. 
 
Microsteps Per Inch: This setting matches the motor driver steps to the KCAM software.  These 
numbers are critical for files to be cut and engraved at their actual size. These numbers are preset at 
the factory. 
 
Divisor, Enable Highspeed and High speed micro steps:  Set at the factory and should not be 
adjusted. 
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Motor Direction: The X and Y motors can move in two directions, forward and reverse.  This setting 
allows the motors to reverse direction. The setting is preset at the factory.  If a new motor or wiring 
harness is installed you may need to change this setting. 
 
 
Installed Options 
 
Second Air Valve: Call Factory 
 
Height Follower: Call Factory 
 
 
Table Alignment 
 
Alignment Offset Distance: Sets the 0,0 point of the machine. When both the X and Y limit 
switches, it moves away from the switch the distance set here. This offset distance is set at the 
factory. Refer to the System Calibration chapter for directions on how to 0,0 your table. 

 
Align Direction: The align direction tells the motors which direction they need to turn for the 
machine to align itself.  If the machine aligns the wrong direction in either the X or the Y, check the 
boxes here. 

 
Ramp down Distance:  Set at the factory and should not be adjusted. 
 
 
Motor Controller Limits 

 
Delay from Direction to Step: Measured in uS. 10.0 is default. 
System Tab 
 

          
                  Table Settings, System 
 
 
 
Language and Units 

 
Units and Speed base in units. 
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Tcp control interface 
 
For k-vision. Call Kern factory for correct settings. 
 

 
Controller 
 
Controller: Parallel or USB 
 
Controller Port: Set to 378 if using Parallel Port. 
 

 
Note command line 
 
Directory for note pad. 
 

 
TCP XPS Printer Server 
 
Call Kern factory for correct settings. 
 
 
 
 

Cut Icon 
 

This screen allows you to start the cutting and/or engraving of a file. 
 

 
                          Cut and Engrave Menu 

 
 

Array Status 
 
Enable: When checked, this will create an array if you have enabled and set distances in the Misc 
Settings tab under the Setup button. The X and Y boxes allow you to run a file from the beginning, or 
skip certain rows and columns to start at a different arrayed part. 
 
 
 
 

49 



 
Repeat  
 
Enable: When checked the laser will pause when finished with a file.  By pressing the Enter key you 
can start the file over again. The pause can be removed under the Setup button, Misc settings tab, 
Automation section. 
 
Align each time: When checked, the system will go to the home position and align the table before 
repeating the file again. 
 
Use Counter: Sets a count of how many repeats of the file you want to process. 
 
 
Settings 
 
Cut vector files: Check to cut a vector file. 
 
Engrave image files: Check to engrave a raster file. 
 
Check both boxes for a cut and engrave combination. Laser will engrave first, then cut. 

 
“Soft Home” at end: By checking this you are enabling the new home position, set at Misc Settings 
in the Setup Menu. 
 
Enable Height Follower: Enables or disables Height Follower feature. 

 
Action 
 
Start/Continue (Enter) (F9): Starts or resumes the cutting or engraving of the file. 
 
Pause: Pauses motion immediately (Hard Pause). Use mouse to click or press ESC key. 
 
Air On/Off: Turns optics air on to test for proper setting. 
 
Height Follower Up/Down: Moves height follower head down to set proper gap from nozzle to 
metal part. 
 
Go Home: Drives to the Home position. 
 
Soft Home: Drives to the Soft Home position. 
 
Align: Table returns to the Home position and presses the limit switches. 
 
Pause at end of line: Pauses at the end of the line it is currently on (Soft Pause).  
 
Pause at next part: Finishes current vector line or part then pauses. 
 
Manual: Opens the Test Screen 
 

 
Position in File 
 
The display window shows what line of the file you are on. By editing the Line box you can skip 
ahead or move back to any line in the file. 
 
Set to start: Starts cutting or engraving at beginning of the file. 
 
Line: Starts cutting or engraving at beginning of previous/next line. 
 
File: Starts cutting or engraving at the beginning of previous/next file. 
 
Back to pause: Resumes cutting or engraving where last paused. 
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Test Icon (Test/Manual Mode) 
 

The Test Mode allows users to manually test the motion, laser and other aspects of the laser system. 
This mode is also used when aligning the laser beam and setting the focal height of the nozzle. 

 

 
                  Manual Mode 

 
 
Current Position: Displays the current X and Y coordinates of the laser on the table top. If your 
current position is invalid you must align your table (F6) before you can use manual mode. 
 
Set User Offset Position: By selecting one of the ten options under the drop down menu, the file 
will move to the set location.  
 
Align Table: Sends the table to the home position to contact the X and Y limit switches which will set 
the correct alignment. 
 
Go Home: Moves the laser back to the home position, does not align. 
 
Height Follower: Enables the height follower to lower and start sensing. 
 
Air: Turns the air to the nozzle on and off. The air pressure is adjustable on the front of the machine 
with regulators. Air must be on for the laser to fire. 
 
Air2: Allows the nozzle air2 to be set to a different pressure during the laser pierce time. 
 
Fire Laser: Turns the laser ON. Press again to shut off the laser or press ESC key. 
 
On Time: Pulses the laser for a set amount of time. A setting of zero will keep the laser on until you 
turn it off. 
 
Laser Power: Sets the laser power for testing. 
 
Speed: Sets the motor speed for testing motion. Do not exceed 10 IPS. 
 
Directional Pad: Moves the laser anywhere on the table top by using the mouse to click the directional 
pad or by using the directional keys on your keyboard. 
 
Enable Arrow Keys: Enables the keyboard directional pad. 
 
Jog to Position: Jog to a position on the table by entering X and Y coordinates. 
 
Open Engrave Dialog: Opens the Cut Screen 
 
Output Status: Shows the state of the switches on the system. 
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An optional metal cutting option can be installed with a 150 watt or larger laser. This option includes 
the hardware and software needed to successfully cut some thin gauge sheet metals. 
 
When cutting metal please remove the honeycomb bed and insert the more durable black gridwork.  

 
For 150W and 200W lasers do not attempt to cut thicker than .075” stainless steel and .090” mild 
steel. 
 
For a 250W laser do not attempt to cut thicker than .090” stainless steel and .125” mild steel. 

 
For a 400W laser please do not attempt to cut thicker than .125” stainless steel and .1875” mild 
steel. Some 400W lasers are equipped with a beam protection system for cutting up to .060” 
aluminum. 

 
 
Optics Assembly 
 

 
Metal Cutting Optics Assembly 
 
 
Setting the Focus Height 

 
The focus height of the metal cutting optics assembly should be set prior to its first use. To do this: 
 
1. Turn OFF the Height Follower box. 
2. Find a flat surface that you can lightly cut into, a piece of polished marble or flat wood will work. 

Place a piece of masking tape horizontally across the material (12” across). 
3. Turn the focus adjustment knob so the tip is .020” above the masking tape. 
4. In the manual mode of KCAM set the laser power to 5% and the speed to .5”/sec. A light air 

should be set so no smoke from the burning tape gets into the nozzle assembly. 
5. Make sure you are cutting with shop air and NOT oxygen when setting the focus height. 

(A) Capacitance Sensor: Senses the 
capacitance from the tip of the nozzle to the 
metal being cut.  

 
(B) Height Follower Wire: Connects 
capacitance sensor to nozzle. 
 
(C) Optics Air: An assist gas is hooked up to the 
nozzle to flush the optics and assist in cutting 
metal. 
 
(D) Metal Cutting Nozzle: Copper nozzle to be 
adjusted .020” away from the metal being cut. 
 
(E) Focus Adjustment Knob: Adjusts the Optic 
assembly up or down. 
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6. Turn ON the laser beam and move the laser head left or right over the tape while turning the 

focusing adjustment up or down until you have the narrowest line width in the material. 
7. When you are cutting with the narrowest line width turn OFF the laser and stop motion. 
8. Measure the gap between the bottom of the nozzle and the tape. 
9. If your narrowest line is at approximately .020” above the tape your lens is focused properly for 

metal cutting. 
10. If the gap is less than or greater than .020” please move onto the next step. 

 
Adjusting the lens to get back into focus: 
 
11. Unplug the Height Follower wire and airline and remove the metal cutting optic assembly. 
12. Using the lens removal tool from your laser tool kit unscrew the top black lock ring. 
13. Gently remove the lens and O-ring from the assembly and place them on a clean cloth. 
14. Adjust the bottom black lock ring up or down to move the lens in focus. Small adjustments of 

about ¼ to ½ turn should be made. 
15. Insert the plastic O-ring back into the optics assembly. 
16. Gently insert the lens back into the optics with the flat surface facing down towards the nozzle 

and the convex side up towards the ceiling. 
17. Screw the top lock ring back into the optics and gently snug to the lens. Do not over tighten or 

the bottom black ring will move along with it. 
18. Repeat steps 1-7 to verify that the narrowest cut is now at .020” above the tape. If it is still off 

repeat step 11–17. 
 
 
Programming the Height Follower Sensor 
 

1. Turn the Height Follower switch OFF. 
2. Verify that the sensor wire is connected. 
3. Position the Height Follower knob to the 12 o’clock position. 
4. Place a flat sheet of metal on the laser table and manually adjust the nozzle so it is about 1” 

above the sheet of metal. 
5. Open the gantry lid and press the sensor button at the top of the height follower card. The light 

should blink a few times and then stay green. 
6. Turn the Height Follower switch ON. 
7. In KCAM click the Height Follower Up/Down and adjust the Height Follower slider bar so that the 

nozzle is .020” above the sheet of metal. 
8. If the nozzle will not adjust to .020” above the metal, repeat steps 1–5 and use a different 

distance for step 4. 
 
 
Setting the Focus Gap 
 

The focus gap of the metal cutting optics assembly should be set prior to its first use. To do this 
please:  

 
1. Place a sheet of metal under the nozzle assembly.  
2. Open the gantry hood and position the Height Follower between the upper and lower limit 

switches. 
3. Set the Height Follower knob at the 12 o’clock position and Turn ON the Height Follower box. 
4. The lens assembly will now move up until it hits the upper limit switch.  
5. In KCAM click the Height Follower Up/Down and the optics assembly will move down and pause 

just above the metal. 
6. Adjust the slider bar so that the nozzle is .020” above the metal. 
7. If the nozzle drives into the piece of metal turn OFF the Height Follower sensor and reprogram 

the sensor with the instruction above. 
 
 

How to Cut Sheet Metal 
 

If you have no experience cutting metal with a Kern laser system it is recommended to start with a 
thin gauge steel about .020”-.040” in thickness. 
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1. Remove the aluminum honeycomb and insert the more durable steel grid work. 
2. Hook up the regulated oxygen supply into the air inlet. 
3. Insert the metal cutting optics assembly. 
4. Do not install the round Lexan Aperture shield to the laser nozzle. This will interfere with the 

height follower sensor and could also be a fire hazard as sparks could ignite the plastic casing. 
5. Connect the sensor wire from the Height Follower sensor to the metal cutting optic assembly. 
6. Connect the air to the metal cutting optic assembly. 
7. Turn ON the Height Follower box. 
8. Open KCAM and select the left Open icon to open: C:\Program Files\Kern\Samples\Moose.plt 
9. When ready to cut click the Cut button. 
10. Set your cutting speed, laser power, frequency, etc. in the Settings Menu and verify that the cut 

vector files option is checked. 
11. Set the air pressure to the correct setting. About 80 PSI should be adequate for .040” steel. 
12. When you are ready to cut click Continue and the laser will move out to the file location and then 

pause. 
13. Click Continue once again and the nozzle will lower to the metal and start sensing (.020” away) 

and then start cutting after the Height Follower Delay. 
14. Once the moose is cut out the Height Follower will move back to the upper limit switch and home 

position. 
15.  
16. Make sure to close the oxygen tank when done cutting. 
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The k-vision package is a fully integrated hardware and 
software solution that allows for accurate registration 
and cutting of printed materials. This process starts 
with a nozzle mounted camera which automatically 
measures the dimensions between registration marks 
on a printed material. The system then uses these measurements and the registration marks of the 
original cutting file to compensate for shift, rotation and distortion. The slight adjustments that k-
vision makes to the cutting file results in a perfectly matched cutout in the material being processed. 
 
 
Overview 
 

  
 

  

(A) Camera Video Cable  
 

(B) Camera Power Cable 
 
(c) Camera Power Light 
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BASIC SETTINGS TAB 
 

 
 
Contrast Multiplier: Sets the camera contrast setting. 
 
Brightness Adjust: Sets the camera brightness setting. 
 
Minimum Target Size: Sets the smallest target size the camera will accept. Set this slightly smaller than 
the actual printed target size. 
 
Maximum Target Size: Sets the largest target size the camera will accept. Set this slightly larger than the 
actual printed target size. 
 
Threshold Percent: Accuracy percentage at which the camera picks up targets. 
 
Manually accept first target: When checked, must click accept for the first target being found. 
 
Update User Offset: 
 
File Color: Set to the hairline color of the target in your file. 
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ADVANCED SETTINGS TAB 
 

 
 
Camera to use: 
 
Target Detector Method: Matching algorithm used for calibration tests. 
 
Target Detector Shape: Preloaded image files for calibration tests. Default is BlackCircle. 
 
Target Detector Image: Custom .BMP file used for calibration tests. 
 
Mirror and average template image: 
 
Check 90 degree rotations: 
 
Manually accept all targets: When checked, must click accept for each target being found. 
 
Center and recheck each target: When checked, each time the camera locks onto a target, it will find it a 
second time before moving to next target. 
 
Number of threads: Sets how much processing speed K-Vision uses on the computer.  Default is 4. 
 
Adjustment Method: Select how the file is orientated once the targets are found. Full Correction is the 
default method. 
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CALIBRATION SETTINGS TAB 
 

 
 
Target Detector Method: Matching algorithm used for calibration tests. 
 
Target Detector Shape: Preloaded image files for calibration tests. Default is BlackCircle. 
 
Target Detector Image: Custom .BMP file used for calibration tests. 
 
Mirror and average template image: 
 
Check 90 degree rotations: 
 
Minimum Target Size: Sets the smallest target size the camera will accept. Set this slightly smaller than 
the actual printed target size. 
 
Maximum Target Size: Sets the largest target size the camera will accept. Set this slightly larger than the 
actual printed target size. 
 
Threshold Percent: Accuracy percentage at which the camera picks up targets. 
 
Calibration Cut Shape: Sets the targets shape when using the offset calibration. Default is round. 
 
Calibration Shape Size: Sets the size of the target shape to cut when using the offset calibration. 
 
Offset X,Y: Automatically set after the offset calibration is completed. 
 
Pixels per inch X,Y: Automatically set after the resolution calibration is completed. 
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CALIBRATION SCREEN 
 

 
 
Start Resolution:  The Start Resolution feature compensates for fish eye and distortion.  This procedure 
should be ran anytime the vertical distance from the camera to the nozzle tip has changed. To enter the 
calibration screen click Actions > Calibrate Vision Camera. 

 
1.) Click Start Resolution.  Instructions will appear in dialogue window. Follow the instructions. (A 

small black circle approximately .1” to .125” is required.) 
2.) Move to where the camera can see the small black circle.  Once the camera has locked onto the 

circle, click accept target. 
3.) The camera will go through a routine to set the resolution.  Once finished, a message will appear 

in the dialogue window. 
 

Start Offset: The Start Offset feature sets the distance from the center of the nozzle to the center of the 
camera for both X and Y.  This procedure needs to be ran anytime the Camera assembly is taken off and put 
back on. To enter the calibration screen click Actions > Calibrate Vision Camera. 

 
1.) Click Start Offset.  Instructions will appear in the dialogue window.  The system will cut a circle.  

The speed and power for the circle is set by the color black in the Vector Colors tab.  The size of 
the circle is controlled in the Settings button on this screen. 

2.) Remove the circle cut in the paper.  Click next.  The camera will move to the cut circle.  Once 
locked onto the circle, click accept target. 

 
Note: The circle created in the Start Offset feature can be used for the Start Resolution feature. 

 
Arrow Keys: Clicking this allows the arrow pad to be accessed.  This enables the user to manually move the 
camera/focusing head around. 

 
Accept Target:  Manually accept targets when locating registration marks.  

 
Skip Target: Skips the current registration target K-Vision is looking for. 

 
Settings:  This accesses the different parameters the K-Vision program has. 
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Help: 

 
Close: Closes the Calibrate Vision Camera window. 
 
 
CAMERA VIEW SCREEN 
 

 
 
Target History: K-Vison keeps a history of the different targets that have been used.  These targets can be 
accessed here. 

 
Arrow Keys: Clicking this allows the arrow pad to be accessed.  This enables the user to manually move the 
camera/focusing head around. 
 
Settings: This accesses the different parameters the K-Vision program has. 

 
Close: Closes the View Camera Vision window. 
 

 
K-VISION OPERATION 

 
1.  Print or open a file into KCAM. 

 2.  Set the speed and power for the cut under Vector Colors. 
 4.  Check Enable Camera Vision and Cut Vector Files. 

5.  Click start.  The camera will move towards the first target.  The first target will be highlighted on 
the preview screen. 
6.  Use arrow keys to move camera over the first target. 
7.  Once camera has locked onto the first target, click Accept. 
8.  The camera will move to the next target. 
9.  Once all targets are found, the head assembly will move to the first cut. 
10. Press Enter or click Start to begin cutting. 
11. Repeat process for each file being processed. 
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A rotary attachment can be factory installed on Kern's laser systems for processing of pipes, rods and other 
cylindrical items. The rotary device is driven by a high resolution servo motor, resulting in smooth and accurate 
cutting performance. 
 
 
INSTALLING THE CHUCK ROTARY STAGE 
 

1. Turn ON the laser system and align the gantry. 
2. Remove the paper, honeycomb and front two ecolite pieces. 
3. Secure the rotary device to the front of the table with the four bolts provided. 
4. Turn OFF the laser system. 
5. Hook up the rotary harness to the rotary plug. 
6. Turn ON the laser system, Open KCAM, Click Test and enable the Z Rotary Mode checkbox. 

 
 
CORELDRAW SETUP 
 

1. Measure the distance from the left side of the table to the right edge of the rotary chuck. 
2. Open a new file and create a guide along the left side that is set at the distance 

determined in Step 1. Make sure to place all artwork on the right side of this guide so that 
the laser nozzle does not hit the chuck. 

3.  Print your artwork to KCAM. 
 
 
KCAM SETUP 
 

1. Measure the diameter of your pipe. 
2. In KCAM go to Setup, Click on the Misc. Settings tab and enter the measurement from 

Step 1 in the Diameter box of the Rotary section. 
3. Insert your pipe into the rotary stage.  
4. Set the cut/engrave settings for the material you are processing. 
5. Click the CUT button, enable the Rotary Mode checkbox and enable the vector and/or 

raster modes that you will use. 
6. Click Start. The X axis will move to the right first and then the Y axis will move to the 

front of the machine. The rotary will stop over the rotary device and centered front to back 
over your pipe. 

7. Set your focus on your material and click the Continue button. 
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CorelDRAW is a graphics software that offers the ability to print over vector and raster files directly 
to KCAM through the Kern EMF Printer Driver. Files may also be saved as a .TIF or .PLT file and 
opened directly into the KCAM software. 
 
Important Notice Regarding Color Fills: When using CorelDRAW X5 and X6 please set the preset 
for the default color management setting to “Simulate Color Management Off”. 

 
Initial Setup 
 

CorelDRAW will be setup correctly when you receive your laser system. If a fresh copy of CorelDRAW 
is installed on your computer please use the below steps to get your default settings back. 
 

1. Open CorelDRAW 
2. Uncheck both boxes at bottom of the Quick Start screen. Close the Quick Start screen. 
3. Click New Document, check do not show again in lower left. Click OK 
4. Set Table size. (Width and Height will vary by machine) 

 

 
Create a New Document 

 
5. Windows > Color Pallets > Select RGB Pallet. 
6. Windows > Color Pallets > Unselect Default Pallet. 
7. Tools > Color Management > Default Settings > Presets > Simulate Color Management Off 
8. Click Tools > Options > Global > Printing > Driver Compatibility 
9. Select the Kern EMF Printer and check the box Send Beziers and paths to driver. 
10. Click OK. 
11. Set Pen outline to Hairline > Tools > Save Settings as Default.  
12. Close Document, Open new Document, Set Pen outline to Hairline > Tools > Save Settings as 

Default. (Takes two times to apply) 
13. Delete any objects from your screen, Tools > Save Settings as Default. 

 
 
Kern EMF Printer Driver 

 
The printer driver will be preinstalled on your machine and ready for use. If for any reason the 
printer driver is not installed follow these steps to install the Kern EMF Printer Driver. 
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1. Start > Devices and Printers 
2. Add a Printer > Add a local printer > Create a new port: Local Port > Next 
3. Name the port: KERN > OK (KERN must be capitalized) 
4. Have Disk > Browse > C:\Program Files(x86)\Kern\KCAM7\Printers\KernEMF.inf > OK > Next 
5. Kern 600 DPI Printer > Next >Install this driver software anyways > Finish 
6. Add a Printer > Add a local printer > Use existing port: KERN > Next 
7. Have Disk > Browse > C:\Program Files(x86)\Kern\KCAM7\Printers\KernEMF.inf > OK > Next 
8. Kern 300 DPI Printer > Next >Install this driver software anyways > Finish 
9. Table > EMF Port > EMF File Loading -> select both checkboxes and set Directory to C:\My 

Documents\KcamEMF\*.EMF > OK 
10. Select the printer driver settings > Edit 
11. Enter the correct DPI, table size and set the output location to:  

C:\My Documents\KcamEMF > OK 
12. Restart computer 

 
 

 
 

 
The Kern EMF printer driver allows for creation of an .EMF file that combines cutting and engraving 
into one common file. The file is created in a folder and then automatically opened into KCAM. To 
use the driver use the following steps: 
 

1. Open KCAM 
2. Create or open the CorelDRAW file you wish to send to the laser. 
3. File > Print 
4. Select the Kern EMF Printer Driver, set Page to Use Printer Default and click Print. The 

EMF file will automatically load into KCAM. (KCAM must be open) 
 
 
Create a .PLT Cutting File 
 

1. Create the black hairline shapes that will be cut. 
2. File > Export. 
3. Choose a name for your file and location to save to. Select PLT – HPGL Plotter for Save as 

type. 
4. Click Export. 
5. The first tab on the HPGL Export screen is the Page tab. In this tab set the Size to Custom, 

Plotter Origin to bottom left and Plotter units to 1,000 per inch.  
6. The second tab is the Pen tab. Match the order of the colors here with the order from the 

Vector Colors tab in KCAM. The purple and orange need to be setup as custom. For purple 
use the last column, fourth row and for orange use the second column fourth row. Once 
these are all set name the pen library “Kern Colors” and click Save. 

7. The last tab is the Advanced tab. In this tab please set the Curve resolution to .001 
inches and check No width or velocity commands. 

 
8. Click OK and your .PLT file will be created. On futures .PLT exports these settings will be set 

as default. 
 
 
Creating a .TIF Engraving File 
 

1. Create the image that will be engraved. 
2. File > Export 
3. Choose a name for your file and location to save to. Select TIF - TIFF Bitmap for Save as 

type. 
4. Click Export. 
5. The Convert to Bitmap screen will appear. Select your desired DPI and choose Color mode: 

Grayscale (8-bit). Uncheck Transparent Background.  
6. Click OK and your .TIF file will be created. On future .TIF exports these settings will be set as 

default. 
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Setting the Cut Order 
 

1. Once you have a file that you want to order go to the Tools tab and select Object Manager. 
2. Your parts will show as a list at the right in the Object Manager box. 
3. Highlight and drag the items to move them up or down the list. 
4. KCAM will start cutting from the bottom of the list and move up. 
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Printing to KCAM 
 

1. Open AutoCAD and create or import your cutting file. 
2. Open KCAM. 
3. When done with AutoCAD drawing, go to File > Print. 

 

      
       AutoCAD Print Screen 

 
 

4. Use the following settings: 
 
Printer Name: Kern EMF Printer Driver (or similar name) 
Paper Size: Custom 
Plot Area: Extents 
Scale: 1:1, 1 inch = 1 unit 
Plot Style = acadlt.ctb 
Drawing Orientation = Landscape 

 
5. Click OK. 
6. The file should now be in KCAM. 
7. On future prints you can select <Previous Plot> under page setup and the settings will 

automatically be set from the previous print. 
 
 
Selecting Cut Order 
 

1. Draw cutting paths or open an existing file. 
2. Insert > Create Block 

a. Name the Block 
b. Select Delete under Objects 
c. Click Select Objects and click on the parts one by one. (The order the objects are selected 

is the order they’ll cut.) 
d. Click Enter. 
e. Click OK. is the order they’ll cu 
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                                                    AutoCAD, Block Definition 

 
 

3. Insert > Insert 
a. Name (choose block previously created) 
b. Insertion point (NOT selected) 
c. Scale (NOT selected) 
d. Rotation (NOT selected) 
e. Explode (selected) 
f. Click OK. 

 

 
                   AutoCAD, Block Insert 

 
 
 
Creating a Polyline 
 

If your file is sent over to KCAM as multiple line segments and not one continuous cut you can use 
the polyline function to combine it into one continuous line segment. 

 
1. Type command pedit and press <ENTER> 
2. Select one of the line segments 
3. Do you want to turn into one? (Y), press <ENTER> 
4. Enter an option, Click Join 
5. Select Objects by creating a window around all pieces or select each one individually. 
6. <ENTER> 
7. Exit Command. Type X 
8. <ENTER> 
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The PhotoGrav software optimizes photographs for laser engraving. If you are installing a fresh copy 
of PhotoGrav please use the directions below to get started. If the software is preinstalled on your 
computer you may begin processing photos. 
 
Installing PhotoGrav 
 
1. State PhotoGrav and go to File > System Defaults > Select Machine. 
2. Choose the KERN HSE machine with appropriate laser size. 
3. Under the Machine Properties select your laser wattage, max speed and a turn time of .142 

seconds. 
4. Set your DPI, spot size (.005”) and machine watts (same as laser power above). 
5. Click OK. 
6. The software is now setup with these default settings and the next time you open this software 

you can begin processing files immediately. 
 
 

Processing a Photo 
 

1. Start PhotoGrav and use the Open Image button to load your photograph. 
2. Click Select Material and choose the material that you will be engraving on.  
3. Click Resize Image to set your desired image size and DPI.  
4. Click Final Process. 
5. Click Save Image and save as an engraved .BMP file. 
6. The file is now ready for importing into your favorite design software (CorelDRAW, Illustrator, 

etc.). 
 

 
                                Photo loaded into PhotoGRAV and final results in KCAM. 
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Maintenance and service procedures of the laser beam optics assembly (cleaning and maintenance of 
the lens and mirror) are to be conducted only by personnel who are familiar with laser safety and 
with the potential laser hazards from the product. 
 
Turn off the laser and close the shutter during lens and mirror cleaning, as operation of the laser 
without the lens or mirror installed can result in a potential laser hazard from the invisible output 
beam, even at distances of hundreds of feet away from the system. 
 

Daily 
 

1. Check for any frayed wires or leaking water lines. 
2. Motion of table and laser should not interfere with any objects. 
3. Verify that air is coming from the nozzle. If not, turn on the air compressor and turn up the air 

pressure to desired level. 
4. Clean any dust and debris from the system including power supplies and any other components. 
5. Replace paper table covering as needed with thin paper. Newspaper roll remnants work well for 

this. 
6. Shut off power to the laser system each day. 

 
Weekly 
 

After starting the laser system, check the water level in the chiller unit (100 watt and above). Make 
sure all chiller filters are free of dust and debris.  
 
Note: Refer to maintenance section of your chiller manual for complete description of your chillers 
maintenance schedule. Also, refer to your laser manual for additional information on required coolant 
additive and mixture ratio. 
 
Remove the 1” aluminum honeycomb and the 1” aluminum Ecolite from the vacuum table top. Clean 
the top honeycomb, ecolite and bottom of the vacuum table with degreaser to remove any debris or 
water material buildup. If there is any waste material debris stuck in the honeycomb or Ecolite, use a 
portable vacuum cleaner to clean it. 
 

Monthly 
 

Top Gantry Rails 
 
Use 4 in 1 oil to lubricate the bearings on the X axis rails once every month. This may be required 
more often with heavy use of the laser system. Wipe rails with a clean, dry cloth before lubricating 
the bearing. 

 
 
 Y Axis Rail and Rack and Pinion Drive 
 

The Y axis features a dual rack and pinion drive and linear rails. Lubrication is critical. Failure to 
sufficiently lubricate will result in premature wear and/or component failure. There are six grease 
zerks, three on each gantry leg. Apply grease to all zerks once a month, when operating 40 hours 
per week. As run time increases, increase frequency of lubrication accordingly. 

 
 

Chilling Unit 
  
  

A chilling unit is typically supplied with lasers that are of 100 watts or greater. These units require a 
monthly maintenance check.  
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A dust/particle filter at the front panel of the chiller can be removed and cleaned with a compressed 
air gun. If the filter is clogged to the point where it cannot be cleaned out please contact Kern for a 
replacement filter. 
 
The chiller reservoir tank requires distilled water and a cleaning solution to keep the lines clean. 
Over time the water can turn murky and contain sediment. Please refer to your chiller owner’s 
manual for detailed instructions on filling your chilling unit with fresh distilled water and a cleaning 
solution. 
 
A more detailed section on chiller maintenance is available in the chiller owner’s manual. Please refer 
to this manual for a full maintenance schedule on the chilling unit. 

  
  
Mirrors 
 

The instructions below are for removal, cleaning, and installation of the mirrors. Refer to the optics 
assembly drawing in the System Diagrams section of this manual. 
 
To remove the mirror for cleaning: 
 

1. Turn OFF the laser machine. 
2. Remove the four 7/64” Allen head screws on the mirror cover. The two mirrors inside the 

gantry will not have mirror covers. 
3. DO NOT remove, tighten, or loosen the three Allen screws under the mirror cover that hold 

the mirror support in place as this will take the mirror out of alignment. 
4. Use the small flat blade screwdriver to remove the three screws on the mirror retainer. 
5. The mirror is now exposed and can be removed for cleaning. Carefully remove the mirror, 

handling it with a clean rag or rubber gloves by the side edges. Avoid touching the front side 
of the mirror, check it for any physical damage. The mirrors have a shiny gold surface. It is 
very important to clean the optics if you think they are dirty or they will become 
permanently damaged. If the mirrors are chipped or cracked, cleaning of the optics will not 
repair the damage. 

 
To clean a mirror: 

 
1. Flush the mirror with 99% isopropyl alcohol. 
2. Remove visible debris from the mirror by wiping it with a Q-tip soaked in isopropyl alcohol 

(rubbing alcohol). 
3. Flush the mirror with isopropyl alcohol. 
4. Using a lens tissue soaked in isopropyl alcohol, wipe the optic lightly in a circular motion very 

lightly. 
5. Repeat step 3 with a new lens tissue. The isopropyl alcohol dries very quickly. The surface of 

the mirror must be clean and shiny when cleaning is finished. If the mirror is chipped, 
cracked or will not clean up properly, replacement optics must be purchased to achieve 
optimum laser cutting and engraving performance. 
  

To reinstall the mirror after cleaning: 
 

1. Carefully place the mirror in the mirror retainer. The mirrored side of the mirror should face 
the side that the laser beam will reflect off of. 

2. Replace the three slotted screws. 
3. Replace the mirror cover with the four Allen screws. 

 
NOTE: It is recommended to check the beam alignment after removing and reinstalling a 
mirror. 
 

 
 Lens 
 

Below are instructions on removal, cleaning, and installation of your optics lens. Refer to the optics 
assembly drawing in the System Diagrams section of this manual. 
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To remove the lens for cleaning: 
 

1. Turn OFF the laser machine. 
2. Disconnect the air line, safety shield and HF sensor wire (metal cutting) from the optics 

assembly. 
3. Unscrew the optic assembly from the beam path tube. 

 

 
                                       Optics Assemblies 
 

4. Use the lens removal tool to unscrew the top lock ring. 
5. The lens is now exposed and can be carefully removed by holding it by the sides only. Set 

the o-ring to the side. Use a clean rag or rubber gloves to carefully remove the lens. Avoid 
touching the front and back surface of the lens. Check for any scratches, pits and blemishes. 
The lens will have a yellowish color to it without any cracks or blemishes. It is very important 
for the optics to be clean. If a lens has blemishes or damage, cleaning of the optic may not 
repair the damage.  
 
NOTE: The lens may appear clean in the assembly, but may still be dirty.  The lens must be 
taken out to check for cracks and blemishes.  

 
 

 
To clean a lens: 

 
1. Remove visible debris from the lens using a Q-tip soaked in isopropyl alcohol or rubbing 

alcohol (90% alcohol based). 
2. Flush the lens with 99% isopropyl alcohol. 
3. Using a lens tissue soaked in isopropyl alcohol, wipe the optic lightly in a circular motion. 
4. Repeat step 3 with a new lens tissue. The isopropyl alcohol dries very quickly. The surface of 

the optic should be clean and spotless when cleaning is finished. If blemishes on the optic 
will not clean off, a replacement optic should be purchased to achieve optimum laser cutting 
and engraving performance.  

 
 
To reinstall the lens after cleaning: 

 
1. Carefully place the lens back in the optics assembly on top of the o-ring. The convex side of 

the lens must be facing upwards as it is placed back in the optics assembly.  
2. Screw the black lock ring back into the assembly using the lens tool. 
3. Reinstall the optic assembly back into beam path tube. 
4. Reconnect the air line, shroud and the HF sensor wire (if present). 

 
NOTE: It is recommended to do a beam alignment through the nozzle after you reinstall the 
lens. 
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This section is for troubleshooting potential problems that occur with your laser system. It is very 
important that you follow the troubleshooting procedures exactly. If you don’t understand the 
procedure contact the factory and a technician will work with you on troubleshooting the laser 
system. 

  
Toll Free: (888) 660-2755 (US & Canada only) 
Phone: (218) 631-2755 
Fax: (218) 631-3476 
Email: help@kernlasers.com 
Office Hours: Monday–Friday, 8:00 AM–4:30 PM, Central Standard Time 

 
 

KLMC Display 
 
The Kern Laser Monitor Controller has multiple lights that monitor the status of the laser systems 
components. There are three different colors that you may see at any given time. 

 
GREEN – This indicates that this function is satisfied and ready to laser cut or engrave. 
 
AMBER – This indicates that there was an alarm but has been corrected. To clear this amber light 
simply cycle the key switch and wait five seconds for the light to turn green. 
 
RED – This indicates an alarm. To troubleshoot the alarm please refer to its corresponding section 
below. 
 
NOTE: The DSP Enable and Laser Enable will not show green until the cut or engrave has started. 

 

 
     KLMC Display 
 
 

E-STOP 
 
This light indicates that an emergency stop switch has been activated.  Each system has from 2 to 4 
emergency stop buttons depending on the table size. To disengage an emergency stop button, twist 
and pull back on the red knob. 
 
 
Over Temp 
 
This light indicates an over temperature signal has been received from the laser unit.  The KLMC will 
shut off power to the laser to protect it from overheating. This fault may be caused by the room 
temperature being too warm. Room temperatures should be kept between 60 - 80 degrees. Also 
check that your chiller is set at a cooling temperature of 68–70 degrees Fahrenheit. 
 
 
 
Ionized (KT model lasers only) 
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This light indicates the RF power supply circuit has encountered a mismatched RF signal. The KLMC 
will shut off power to the laser to protect the laser and power supply. If this fault occurs, contact 
Kern for further assistance. 
 
 
SWR Fault 
 
This light indicates the RF power supply circuit has encountered a mismatched RF signal. The KLMC 
will shut off power to the laser to protect the laser and power supply. If this fault occurs, contact 
Kern for further assistance. 
 
 
Interlock 
 
This light indicates that the interlock circuit is opened. The doors and windows are tied in series to 
this circuit to prevent the laser from firing while open. 
 
 
Air Valve 
 
This light indicates the main air switch is opened to allow air to be regulated. 

 
 

Laser Pulse 
 
This light indicates that the laser is cutting or engraving. It is normal for this light to stay a hard 
green or blink ON and OFF. 
 
 
DSP Enable 
 
This light indicates that the DSP box has communication with KCAM. The light will turn green once 
the laser starts the cut or engrave job. 
 
 
Water Flow 
 
This light indicates if there is no water flowing to the laser from the chilling unit. Please check to 
make sure that the chiller is ON and that the hoses are hooked up correctly to the inlet and outlet. 
 
 
Air Supply 
 
This will turn green when there is 65 lbs. of air coming into the laser system. Check to see that the 
air is plugged in at the back of the system and your air tank is open. 
 
 
Shutter 
 
This light indicates the status of the shutter. The shutter this is located on the back of the gantry 
between the laser unit and first mirror. Slide the shutter mechanism to the open position if you want 
to use the laser. Slide the shutter mechanism to the closed position if you wish to disable the laser 
beam. While doing maintenance within the beam path you should always close the shutter. 
 
 
DC Sense 
 
This light indicates if the DC voltage is hooked up to the laser. If there is a red light verify that the 
DC power is on and the power supply is hooked up correctly. 
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Laser OK 
 
This light indicates when the laser is OK and not pulling a laser error signal. 

 
 
Key Switch 
 
This light indicates if the key switch for the KLMC is cycled from ON to OFF. When the machine is 
turned ON for use you must cycle the key switch to clear the red light. There is a five second delay 
for the light to turn to green. 
 
 
Laser Enable  
 
This light will turn green once the cut or engrave file has started. 

 
 
DSP Box 
 

This box is an interface between the computer and the KLMC. The three indicator lights on this box 
are POWER, USB/DATA and DSP ACTIVE. 
 
The POWER light will turn green when the system is turned on. It will turn even brighter green 
when you enter the Cut and Engrave menu or the Manual screen.  
 
The USB/DATA light will blink green upon entering the KCAM Cut and Engrave menu or the 
Manual/Test screen showing communications are taking place between the computer and DSP. It will 
continue to blink green when the laser is running and will turn off once you have exited out of KCAM 
or the laser system is turned off. 
 
The DSP ACTIVE light will turn green when KCAM enables the DSP to operate. 

 
 
Mechanical 
 

Motion 
 
The motion table has an X axis that travels left to right, and a Y axis that travels front to back. The 
travel must be smooth and unrestricted in both the X and Y directions. 
 
 
X Motion Test 
 
Verify that your system is turned OFF, the shutter is closed, and then unplug the cable labeled X 
Motor Power going into the servo amplifier at the front of your system. Open your gantry lid and 
move the optics head along the X axis. The optics head should move smoothly, without any 
restriction. If there is restriction, call the factory for further instructions. Shut the gantry lid and plug 
back in the X Motor Power cable to the servo amplifier. 
 
 
Y Motion Test 
 
Contact Kern for more information. 
 
 
Travel Limit Switches 
 
The Y axis has limit switches on the front and rear which prevent the gantry from over travelling. 
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Home Limit Switches 
 
The motion table has a home X limit switch and two home Y limit switches. The X limit switch is 
momentarily depressed upon the laser moving to its left most position. The Y limit switches are 
momentarily depressed when the gantry moves the very back of the laser system. The table must 
home itself to these limit switches or the motion system will not have a known start reference. 
 
To manually test the home limit switches follow these steps: 
 

1. Open the Manual screen in KCAM. 
 

2. Manually click the limit switches while someone is watching your Manual Screen. The limit 
switch box should toggle OFF to ON. If they do not toggle, you either have a broken wire 
going to the switch or DSP box is defective, call the factory for further instructions. 

 
3. Press the Align button. If the table grinds, hit the ESC key or the Emergency Stop Switch. A 

grinding noise indicates an X or Y motor has lost its location. This can happen because of one 
of the following circumstances: 
 

• The motor has a broken wire leading to it or a defective motor driver module. Check 
for loose wires on the motor. 

• The limit switch has a broken wire leading to it or it is not physically being pressed to 
stop the motion. 

• The table has binding in that axis. Call Kern for technical assistance. 
 

4. After the laser and gantry have reached the limit switches, they will stop and then move a 
set amount to zero the table. The laser nozzle will be just inside the upper left corner of the 
table. This is the home position. If a Soft Home is ON turn it off in the KCAM software. After 
a job is ran the nozzle will return to the home position.  

 
 
Computer 
 

1. Turn off the screensaver. 
2. Modify the computers Power Settings by going to: Control Panel > System and Security > Power 

Options 
a. At the left hand side click Choose when to turn off the display and set both settings to 

Never. Click Save Changes. 
b. Click Change advanced power settings. Choose High Performance from the drop down 

list. 
c. Scroll down and open the Processor Power Management and set minimum and 

maximum processor state to 100%. Click Apply and OK. 
3. Make sure automatic updates and virus scans are set to perform when the laser is not in use. 

 
KCAM requires a dedicated computer to properly run the system. Do not operate other computer 
programs on the laser computer while the laser is in use. The computer is communicating with the 
DSP at all times and any glitch in memory can cause a skip. Also, please make sure automatic 
updates and virus scans are set to occur at a time when you are not using the machine. Do not send 
or take files out of the laser computer through the network when the system is in operation. 

 
 
Electrical 

 
If any component of the laser machine is not working, first check that all plugs are in their socket 
and ON switches are set correctly. If the problem is not corrected have a certified electrician check 
to see if a breaker has been tripped in the electrical panel. If the problem still exists have a certified 
electrician call a Kern technician to troubleshoot the electrical problem. Kern can provide wiring 
diagrams and pin outs to assist. 
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Laser 

 
The laser consists of a laser tube, RF power supply, DC power supply, control signal, and water-
cooling. The following are requirements needed for the laser to fire. 

• AC voltage for the DC power supply. 

• DC voltage for the RF power supply 

• Chilling unit powered on. 
 

• The shutter needs to be in the open position.  

• Air pressure to the nozzle via the automated air switch and regulator provided with the 
system. 

• A five second delay reset. This is the key switch on the KLMC box. 

Failure of any of these will affect the performance of the laser and cause it to not fire. 

  

Laser Power Testing Procedure 
 

A laser power meter is required for this procedure. Please call a Kern sales associate for information 
on purchasing a laser power meter. These meters are great for troubleshooting and tracking the 
power of your laser over its lifetime. 
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Front View Footprint  
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Side View Footprint  
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Mirror Alignment 
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LaserCELL Optics Assemblies 
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LaserCELL Optics Assemblies Parts List 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
  

 
 
 

DESCRIPTION PART NUMBER
2.5" METAL CUTTING OPTICS ASSEMBLY KERN1001
5.0" METAL CUTTING OPTICS ASSEMBLY KERN1002-1

2.5" OPTIC ASSEMBLY KERN1011
5.0" OPTIC ASSEMBLY KERN1012
7.5" OPTIC ASSEMBLY KERN1011-1

 
 

  
  
 
 

 
   
  

 
  
 
 
 
 

NUMBER QTY. DESCRIPTION PART NUMBER
1 3 Lens Lock Ring HSE-1013
2 1 1.00" Diameter x 2.50" F.L. Lens 1585
3 1 1.00" Diameter x 5.00" F.L. Lens (not pictured) 1583
4 2 1.00" Stainless Steel Wave Washer 1898
5 1 K-Lens 1485
6 1 2.50" Lens Holder N-HF-14
7 1 5.00" Lens Holder (not pictured) N-HF-18
8 1 Ceramic Isolator N-HF-13
9 1 Nozzle Retainer N-HF-15

10 1 1/4 x 10-32 90 Elbow 1009
11 1 Copper Nozzle 1093
12 1 Tip Lock Ring N-HF-19
13 1 #4-40 x .250 SHCS 91251A106
14 1 #4-40 Washer 90126A505
15 1 Sensor Wire KERN1022
16 1 Nozzle HSE-1016
17 1 1/4 x 10-32 90 Elbow 1009
18 1 2.50" Lens Holder HSE-1015
19 1 5.00" Lens Holder (not pictured) HSE-1018
20 1 7.50" Lens Holder (not pictured) HSE-1019
21 1 1.00" O.D. O-RING/Wave Washer 1898
22 1 1.00" Diameter x 2.50"F.L. Lens 1585
23 1 1.00" Diameter x 5.00" F.L. Lens (not pictured) 1583
24 1 1.00" Diameter x 7.50" F.L. Lens (not pictured) 1688
25 2 Lens Lock Ring HSE-1013
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LaserCELL Schematics 

 
An exploded view and parts list of the LaserCELL’s detailed footprint, gantry, blower system, height follower 
and other common parts is available online. Please visit the customer login page at 
http://www.kernlasers.com/customer-login. If you do not have a username and password please contact 
your salesman or technical support to receive one. 
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The staff at Kern Electronics & Lasers, Inc. values our customers and takes great pride in the service 
we offer to our customers. The business relationships we have developed are very important to us. 
This page will clarify the service we offer to our customers after the purchase of a Kern Laser 
System. 
 

 
In Warranty Systems 
 

All systems have a one year warranty on the system parts, laser tube and laser power supply. This 
includes either the RF Power supply or the DC power supply, whichever is supplied with the laser 
system. 

 
Warranty does not cover shipping costs from the customer’s location to the Kern factory. 

 
USA and Canada: For any parts sent out to the customer in warranty, Kern Electronics & Lasers, 
Inc. will pay for Ground UPS shipping only. If the parts are needed sooner (Next Day, 2nd Day, etc.) 
or by freight service the customer is responsible for the entire shipping costs.  Any duties, customs 
and/or fees are the responsibility of the customer. 
 
International: Shipping costs and duties/customs/fees to and from Kern Electronics & Lasers, Inc. 
are the responsibility of the customer.  
 

 
Out of Warranty Systems 

 
All parts shipped out of warranty will be charged repair or replacement costs plus all shipping 
charges. Out of warranty repairs of the laser vary by manufacturer. 
 

 
Laser Power Meter 

 
Please call a Kern sales associate for information on purchasing a laser power meter. These meters 
are great for troubleshooting and tracking the power of your laser over its lifetime. 
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LIMITED WARRANTY 

 
 

Customer Name:    Date of Purchase: 
 
Model Number:     Serial Number: 
 

WARRANTY 
 
Kern Electronics & Lasers, Inc. warrants your laser cutting and engraving system to be free from defects in material and workmanship for a period 
of 1 year from the original date of purchase. If you discover a defect in a product covered by this warranty, we will repair at our option using new or 
refurbished components, or if repair is not possible, replace the item. This warranty does not include labor to install the replacement parts. 
 

EXCLUSIONS 
 
This warranty covers defects in manufacturing discovered while using the product as recommended by the manufacturer. The warranty does not 
cover loss or theft, nor does coverage extend to damage caused by misuse, abuse, unauthorized modifications, improper storage conditions, 
lightening, or natural disaster. The warranty does not cover parts that are subject to normal wear and tear replacement requirements, such as the 
optical lens, mirrors, cutting beds, etc. This warranty is non-transferrable. 
 

LIMITS OF LIABILITY 
 
Should the product(s) fail, your sole recourse shall be repair or replacement, as described in the preceding paragraphs. We will not be held liable to 
you or any other party for any damages that result from the failure of this product. Damages excluded include, but are not limited to, the following: 
lost profits, lost savings, lost data, damage to other equipment, and incidental or consequential damages arising from the use, or inability to use 
this product. In no event will Kern Electronics & Lasers, Inc. be liable for more than the amount of your purchase price, and excluding tax, and 
shipping and handling charges. 
 
Kern Electronics & Lasers, Inc. disclaims any other warranties, express or implied. By installing or using the product, the user accepts all terms 
described herein. 
 
 

SERVICE 
 
If you need technical support or service follow the outlined steps: 

1. Refer to the laser manual or the Kern Laser System Manual for assistance. 
2. Refer to our website, www.kernlasers.com/customer_support.htm.  
3. Call Kern Electronics & Lasers, Inc. at 218-631-2755. Please have the following information ready: 

a. Name of your company. 
b. Name and phone number of the contact person in your company. 
c. Description of the symptoms, physical damage, or performance faults. 

 

REQUIREMENTS 
 
Warranty replacement parts will be shipped to customers at a standard Ground Rate. If the customer requires a faster service the entire shipping 
bill will be paid by the customer. Shipping defective parts back to Kern or the authorized repair center is the responsibility of the customer. The 
customer is always responsible for any customs clearance fees and/or duties. If Kern Electronics & Lasers, Inc. authorizes the return of parts, please 
ship them in well packaged containers. Lasers and RF power supplies must be returned in the original packaging and carton. The customer is 
responsible for insuring the product for shipping. Please call Kern if you are unsure of the correct insurance amount for a part. Upon receipt we will 
determine the warranty status of the product. If you are out of warranty you will be billed for parts, labor, and shipping costs. 
 

Kern Electronics & Lasers, Inc. 
1501 Industrial Drive, Wadena, MN 56482 

Phone: 218-631-2755 
Fax: 218-631-3476 
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LaserCELL BEAM ALIGNMENT SHEET 
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